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Introduction

 

The 

 

Activator and APS Programming System Installation and User’s 
Guide

 

 contains information about programming Actel devices using an 
Activator device programmer and the APS programming software. The 
guide is divided into two main sections: Activator installation and setup 
instructions and APS software usage. The installation and setup 
instructions include information about installing the Activator device 
programmers and the Adaptec AVA™-1505 AT

 

®

 

-to-SCSI host adapter 
(1505 card). The APS software usage section contains information 
about using an Activator with the APS programming software to 
program and debug Actel devices.

 

Document Organization

 

The

 

 Activator and APS Programming System Installation and User’s 
Guide 

 

is divided into the following chapters:

 

Chapter 1 - Hardware Description 

 

contains hardware handling 
procedures and descriptions of the Activator 2, 2s, and the 1505 card.

 

Chapter 2 - Hardware Installation on a PC 

 

contains information and 
procedures to install an Activator on a PC.

 

Chapter 3 - Hardware Installation on a Workstation 

 

contains 
information and procedures to install an Activator on a UNIX 
workstation.

 

Chapter 4 - Programming an Actel Device 

 

contains information and 
procedures to program Actel devices using APS programming software.

 

Chapter 5 - Device Programming Failure Guidelines 

 

describes 
conditions that can cause an Actel device to fail.

 

Chapter 6 - Debugging a Device with an Activator 

 

contains 
information and procedures to debug Actel devices using an Activator 
and APS programming software.

 

Chapter 7 - Silicon Explorer Diagnostic Tool 

 

contains information 
and procedures to use the Silicon Explorer Diagnostic Tool.

 

Appendix A - Troubleshooting 

 

describes some common hardware 
and software problems and solutions to those problems.
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Appendix B - AVI File description 

 

contains an example and 
description of an AVI log file.

 

Appendix C - Product Support 

 

provides information about 
contacting Actel for customer and technical support.

 

Document Assumptions

 

The information in this manual is based on the following assumptions:

1. You have installed the Designer Series software, including APSW.

2. You are familiar with PCs and Windows operating environments.

3. You are familiar with UNIX workstations and UNIX operating 
systems.

4. You are familiar with FPGA architecture and FPGA design software.

 

Document Conventions

 

The following conventions are used throughout this manual.

Information that is meant to be input by the user is formatted as 
follows:

 

keyboard input

 

The contents of a file is formatted as follows:

 

file contents

 

Messages that are displayed on the screen appear as follows:

 

Screen Message
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Designer Series Manuals

 

The Designer Series software includes printed and on-line manuals. 
The on-line manuals are in PDF format on the CD-ROM in the “/doc” 
directory. These manuals are also installed onto your system when you 
install the Designer software. To view the on-line manuals, you must 
have Adobe

 

®

 

 Acrobat Reader

 

®

 

 installed. Actel provides Reader on the 
Designer Series CD-ROM.

The Designer Series includes the following manuals, which provide 
additional information on designing Actel FPGAs:

 

Designing with Actel

 

. This manual describes the design flow and user 
interface for the Designer Series software, including information about 
using the ACTgen Macro Builder and ACTmap VHDL Synthesis 
software.

 

Actel HDL Coding Style Guide

 

. This guide provides preferred coding 
styles for the Actel architecture and information about optimizing your 
HDL code for Actel devices.

 

ACTmap VHDL Synthesis Methodology Guide

 

. This guide contains 
information, optimization techniques, and procedures to assist 
designers in the design of Actel devices using ACTmap VHDL.

 

Cadence

 

®

 

 Interface Guide

 

. This guide contains information and 
procedures to assist designers in the design of Actel devices using 
Cadence CAE software and the Designer Series software.

 

Mentor Graphics

 

®

 

 Interface Guide

 

. This guide contains information 
and procedures to assist designers in the design of Actel devices using 
Mentor Graphics CAE software and the Designer Series software.

 

MOTIVE

 

™

 

 Static Timing Analysis Interface Guide

 

. This guide contains 
information and procedures to assist designers in the use of the 
MOTIVE software to perform static timing analysis on Actel designs.

 

Synopsys

 

®

 

 Synthesis Methodology Guide

 

. This guide contains preferred 
HDL coding styles and information and procedures to assist designers 
in the design of Actel devices using Synopsys CAE software and the 
Designer Series software.

 

Viewlogic

 

®

 

 Powerview Interface Guide

 

. This guide contains information 
and procedures to assist designers in the design of Actel devices using 
Powerview CAE software and the Designer Series software.
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Viewlogic Workview

 

®

 

 Office Interface Guide

 

. This guide contains 
information and procedures to assist designers in the design of Actel 
devices using Workview Office CAE software and the Designer Series 
software.

 

VHDL Vital Simulation Guide

 

. This guide contains information and 
procedures to assist designers in simulating Actel designs using a Vital 
compliant VHDL simulator.

 

Verilog

 

®

 

 Simulation Guid

 

e. This guide contains information and 
procedures to assist designers in simulating Actel designs using a 
Verilog simulator.

 

Activator and APS Programming System Installation and User’s Guide

 

. 
This guide contains information about how to program and debug 
Actel devices, including information about using the Silicon Explorer 
diagnostic tool for system verification.

 

Silicon Explorer Quick Start

 

. This guide contains information about 
connecting the Silicon Explorer diagnostic tool and using it to perform 
system verification.

 

Designer Series Development System Conversion Guide UNIX

 

®

 

 
Environments.

 

 This guide describes how to convert designs created in 
Designer Series versions 3.0 and 3.1 for UNIX to be compatible with 
later versions of Designer Series.

 

Designer Series Development System Conversion Guide Windows

 

®

 

 
Environments.

 

 This guide describes how to convert designs created in 
Designer Series versions 3.0 and 3.1 for Windows to be compatible 
with later versions of Designer Series.

 

FPGA Data Book and Design Guide

 

. This guide contains detailed 
specifications on Actel device families. Information such as 
propagation delays, device package pinout, derating factors, and 
power calculations are found in this guide.

 

Macro Library Guide

 

. This guide provides descriptions of Actel library 
elements for Actel device families. Symbols, truth tables, and pin 
loading are included for all macros.

 

On-Line Help

 

The Designer Series software comes with on-line help. On-line help 
specific to each software tool is available in Designer, ACTgen, 
ACTmap, and APSW.
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Hardware Description

 

This chapter contains device handling guidelines and descriptions of 
the Activator 2, 2s, Adaptec AVA-1505 AT-to-SCSI host adapter (1505 
card), and Adapter Module. The Activator 2 or 2s programmers and the 
Adapter Module, and the 1505 card if you are using a PC, are used 
when programming Actel devices.

 

Unpacking Your Activator

 

Unpack your Activator carefully and set it up in a clean operating 
environment. Never expose the unit to excessive heat, such as direct 
sunlight or heating vents and other heat-generating devices. Make sure 
you allow adequate ventilation on all four sides of the unit. The 
programmer is also equipped with rubber feet to raise it above the 
operating surface, allowing further ventilation. Make sure you do not 
block ventilation to the bottom of the unit.

 

Device Handling

 

Actel devices are CMOS devices and require proper grounding and 
Electro Static Device (ESD) handling procedures. Although all Actel 
parts have static discharge protection built in, you should always 
follow ESD handling procedures when handling Actel devices.

You should always wear grounded wrist straps at an ESD workstation 
when handling devices. A calibrated ionizer should be on and 
functioning properly at the workstation. An ionizer air stream should 
be directed over the parts at all times.

Always keep the devices in their anti-static carrying cases until they are 
used, and keep the surrounding environment clean and free of dust 
and debris. Periodically check the Adapter Module sockets to make 
sure that they are free of dirt or other debris that would prevent good 
electrical pin connections between the device and socket.

When loading a device in the Adapter Module socket, be sure that pin 
1 on the device is oriented according to the diagram on the Adapter 
Module. Damage can occur if the FPGA is loaded incorrectly.
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Activator 2 and 2s Rear Panels

 

Actel offers two programming units, the Activator 2 and the Activator 
2s. The Activator 2 is a four-device programmer, with interchangeable 
Adapter Modules that support all of Actel’s device packages. The 
Activator 2s is a single socket version of the Activator 2.

This section describes and illustrates the connectors on the rear panels 
of the Activator 2 and 2s. The connectors are shown in Figure 1-1 
below and Figure 1-2 on page 3.

Figure 1-1. Activator 2 Rear Panel Connectors

Test Ports (Actel use only)

F0123456789ABC
DE

Port 1

Port 2
Port 3

Port 4

SCSI Rotary Switch

SCSI Ports

Power Switch

ActionProbe Ports (4)

Adapter Module
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Common 
Connectors

 

The following connectors are common to the Activator 2 and 2s.

 

ActionProbe Port

 

The ActionProbe Port supports in-circuit debugging using the 
ActionProbe diagnostic tool. The Activator 2s has one port. The 
Activator 2 has four ports, one for each programming socket. The 
ActionProbe has been replaced with the Silicon Explorer, which uses a 
serial port. If you are using an ActionProbe, refer to the documentation 
included with it for information about using the ActionProbe tool.

 

Adapter Module

 

The Adapter Module is plugged into the Activator and used to program 
Actel devices. The Activator 2s can accept one Adapter Module. The 
Activator 2 can accept four. Refer to “Adapter Modules” on page 4 for 
information about Adapter Modules.

 

Power Switch

 

The power switch is used to turn the Activator on and off.

 

SCSI Rotary Switch

 

The SCSI rotary switch is used to select the SCSI bus ID. Refer to 
Chapter 2, “Hardware Installation on a PC” on page 7 or Chapter 3, 
“Hardware Installation on a Workstation” on page 21 for information 
about setting the SCSI rotary switch.

Figure 1-2. Activator 2s Rear Panel Connectors

F0123456789ABC
DE

Adapter Module

SCSI Port

15-Pin D-Sub
ActionProbe Port

SCSI Rotary Switch

DIN Power

Power Switch

Jack
(Designated as “Port 4”

when using the Debugger)
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SCSI Port
The SCSI port is used to communicate with the computer through the 
SCSI interface. The Activator 2s has one SCSI port. The Activator 2 has 
two ports that are connected in parallel.

Activator 2 
Connectors

In addition to the common connectors, the Activator 2 has the 
following connector.

Test Port
The two Test Ports are used for factory diagnostic testing and are not 
available for customer use. Do not connect any devices to these ports.

Activator 2s 
Connectors

In addition to the common connectors, the Activator 2s has the 
following connector:

DIN Power Jack
The DIN power jack is used to connect the power supply (supplied by 
Actel) to the Activator 2s.

Adapter Modules
The Activator 2 has four sockets for Adapter Modules and can program 
up to four Actel devices simultaneously. The Activator 2s has one 
socket for a single Adapter Module. Each device package type has an 
Adapter Module designed specifically for that device. Contact your 
local sales representative for availability of Adapter Modules.

If the Adapter Module does not match the package type of the design 
being programmed, the APS software displays the message “wrong 
adapter type” for each incorrect socket. In each case, replace the 
wrong adapter with the correct one. Refer to “Installing and Removing 
an Adapter Module” on page 19 or page 28 for information about 
installing and removing Adapter Modules from an Activator.
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PC Adaptec AVA-1505 AT-to-SCSI Host Adapter
The 1505 card, included with the Activator, interfaces with the 
Activator 2 or 2s. The 1505 card, shown in Figure 1-3, has an external 
25-pin DB25 SCSI connector.

A jumper block (J1) is located on the left-center of the 1505 card. This 
block is used to configure the I/O address and interrupt number (IRQ), 
if necessary. The default I/O address is 340H-35FH. The default IRQ is 
IRQ11.

CAUTION: The external 25-pin DB25 edge connector can be confused with a 
parallel port connector. Make sure you plug the Activator into the 25-
pin DB25 connector on the 1505 card.

Figure 1-3. Adaptec AVA-1505 AT-to-SCSI Host Adapter

J1IRQ12

IRQ10
IRQ9

IRQ11

DB25 SCSI Connector

Jumper Block
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Hardware Installation on a PC

This chapter contains information and procedures to install an 
Activator 2 or 2s on a PC, including information about configuring your 
1505 card, installing the appropriate software driver(s), hooking up an 
Activator and installing and removing an Adapter Module. Refer to the 
Adaptec AVA-1505 AT-to-SCSI Host Adapter Installation Guide (Actel 
part number AVA-1505, included with the 1505 card) for additional 
information about installing and configuring the 1505 card.

Adaptec AVA-1505 AT-to-SCSI Host Adapter Installation
This section contains background information and describes the 
procedures for installing and configuring the 1505 card on a PC. If your 
PC already contains an Adaptec SCSI host adapter card, you can use it 
instead of installing the 1505 card provided by Actel. Go to 
“Connecting an Adaptec SCSI Card to the Activator” on page 16 for 
configuration information.

Background 
Information

PCs use interrupt numbers (IRQs) and I/O addresses to distinguish 
between different add-in cards. Each add-in card must be assigned a 
IRQ and I/O address. If more than one card uses the same IRQ or 
address, conflicts between the cards may occur. Newer Plug and Play 
cards can be configured by software to use unique IRQs and I/O 
addresses. However, non-Plug and Play, or legacy, cards cannot. When 
installing a legacy card, the user must determine what IRQs and I/O 
addresses are in use by the other cards in the PC so that a unique IRQ 
and I/O address can be selected for the legacy card. The 1505 card is a 
legacy card.

All PCs (486 and newer) contain an ISA (or AT) bus. Additionally, 
Pentium® PCs usually include an additional bus, the PCI bus, used for 
Plug and Play cards. The 1505 card uses the ISA bus, not the PCI bus. 
If your Pentium PC contains a PCI bus, then it has reserved certain 
IRQs for use only by the PCI bus. To use the 1505 card, you must 
configure your computer to access the ISA bus for the IRQ used by the 
1505 card. This is done by changing the setup information in your PC’s 
BIOS, typically during boot-up.
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Installation 
Steps

Regardless of which Windows operating environment you are working 
under (95 or NT), you must perform the following steps to successfully 
install the 1505 card into a PC:

1. Select a unique IRQ and a unique I/O address for the 1505 card.

2. Install the 1505 card into your PC.

3. If your computer is a Pentium PC with a PCI bus, configure the 
selected IRQ to use the ISA bus, not the PCI bus.

4. Configure the software driver(s), with the IRQ and I/O address of 
the driver(s) matching the IRQ and I/O address set on the 1505 
card.

5. If an Activator is sharing the 1505 card with other SCSI devices, 
configure the termination resistors on the 1505 card and the other 
SCSI devices.

6. Connect the Activator to the 1505 card.

Installing the 1505 Card Under Windows 95
This section describes how to install the 1505 card under Windows 95.

Select a Unique 
IRQ and I/O 
Address

The default settings on the 1505 card should work. However, you may 
have an add-in card installed on you PC with IRQ and I/O address 
settings that conflict with the default settings on the 1505 card. The 
conflict may affect your video, network connection, or hard drive. If 
there is a conflict, you must change the IRQ and I/O address of either 
the 1505 card or an installed add-in card.

To select the IRQ and I/O address for the 1505 card:

1. Open the Device Manager window. Double-click the System 
icon located in the Control Panel program group. The System 
Properties window is displayed. Click the Device Manager tab to 
display the Device Manager window.
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2. Determine what IRQs and I/O addresses are in use by 
installed add-in card(s). Double-click the Computer icon. The 
Computer Properties window is displayed. Choose the Interrupt 
request (IRQ) radio button to view the IRQs already in use. Choose 
the Input/output (I/O) radio button to view the I/O addresses 
already in use.

3. Set the IRQ and I/O address for the 1505 card. The default 
interrupt number is IRQ11, but can be set from IRQ9 to IRQ12. The 
default I/O address is 340h-35Fh, but can be set to 140h-15Fh. Refer 
to the “Jumper Block Settings” section in the Adaptec AVA-1505 AT-
to-SCSI Host Adapter Installation Guide for information about 
changing the IRQ and I/O address on the 1505 card.

If all the interrupts between IRQ9 and IRQ12 are being used, you 
must change the IRQ settings on another card to free up one of 
these interrupts for the 1505 card.

Install the SCSI 
Board Into your 
PC

Turn off your computer, remove its cover, and install the 1505 card 
into an ISA expansion slot in the PC. After installing the card, replace 
the cover and turn the PC on. Refer to the “Inserting the Board” section 
in the Adaptec AVA-1505 AT-to-SCSI Host Adapter Installation Guide for 
additional information about installing the 1505 card.

Configure the 
Selected IRQ to 
Use the ISA Bus

If your computer is a Pentium PC with a PCI bus, you must change the 
CMOS setup in your BIOS so that the IRQ used by the 1505 card 
accesses the ISA bus rather than the PCI bus. You can usually change 
the BIOS setup during boot-up. Refer to the documentation provided 
by your computer or BIOS manufacturer for information about 
changing your BIOS setup.

If you don’t know if your Pentium uses a PCI bus, refer to the 
documentation provided by your computer manufacturer or contact 
your computer manufacturer.

IMPORTANT: If your computer uses the PCI bus and you do not change your BIOS, 
even if you have no hardware conflicts, the Activator will not work.

Note: If you remove the 1505 card from your PC, make sure you change 
the BIOS settings for that IRQ back to use the PCI bus.
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Run the Add 
New Hardware 
Wizard 

Windows 95 comes with an Add New Hardware wizard that detects 
new add-in cards and drivers. This wizard automatically assigns an IRQ 
and I/O address to the new card. These settings may not match the 
card’s actual configuration. If the settings on the card do not match the 
settings in the wizard, you must change the settings in the wizard or on 
the 1505 card.

Note: The settings that are selected in the Add New Hardware wizard 
must match the actual settings on the 1505 card, your BIOS, and 
the settings in your config.sys. file. Refer to “Configure the 
Selected IRQ to Use the ISA Bus” on page 9 for information about 
configuring your BIOS and “Configure the Software Driver” on 
page 10 for information about configuring your software driver.

To run the Add New Hardware wizard:

1. Invoke the Add New Hardware wizard. Double-click the Add 
New Hardware icon located in the Control Panel group. The Add 
New Hardware wizard is displayed.

2. Follow the instructions on the screen. Select “No” when asked 
if you want Windows to search for your new hardware and “SCSI 
controllers” when asked for the type of hardware you want to 
install. Choose “Adaptec” and “AVA-1505 SCSI Host Adapter” when 
asked to select Manufacturer and Model for your hardware.

3. Note the IRQ and I/O address. If the IRQ and I/O address match 
the settings you selected for the card, click the Next button. If the 
settings do not match, then change the software settings to match 
the 1505 card settings (see “Configure the Software Driver” in the 
following section) or change the card settings to match the software 
settings (see “Select a Unique IRQ and I/O Address” on page 8).

Configure the 
Software Driver 

Actel uses the driver installed by Windows 95 when you add the 1505 
card using the Add New Hardware wizard. If the settings on your 1505 
card match the setting assigned to the card by the wizard, you do not 
need to configure the software driver. If the settings do not match, use 
the following procedure to configure the software driver.
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1. Open the Device Manager window. Double-click the System 
icon located in the Control Panel program group. The System 
Properties window is displayed. Click the Device Manager tab to 
display the Device Manager window.

2. Open the 1505 card Properties window. Double-click the SCSI 
controllers icon. Double-click the 1505 card icon (it may show up 
as the “Adaptec 1505 SCSI Adapter” driver, the “Adaptec AIC-6260/
6360” driver, or as the “ISA SCSI” driver). The SCSI Controller 
Properties window is displayed.

3. Change the I/O address settings. Click the Resources tab. Make 
sure the Use automatic settings box is not checked. Choose Input/
Output Range in the Resource settings window and click the 
Change Settings button. Change the I/O address to match the 
settings you selected on the 1505 card. Click OK.

4. Change the IRQ settings. Choose Interrupt Request in the 
Resource settings window and click the Change Settings button. 
Change the IRQ to match the settings you selected on the 1505 card. 
Click OK.

To verify that the software driver is configured properly:

1. Open the Device Manager window. Double-click the System 
icon located in the Control Panel program group. The System 
Properties window is displayed. Click the Device Manager tab to 
display the Device Manager window.

2. View the 1505 card properties. Double-click the SCSI controllers 
icon. The 1505 card icon is displayed (it may show up as the 
“Adaptec 1505 SCSI Adapter” device, the “Adaptec AIC-6260/6360” 
device, or as the “ISA SCSI” device). If there is a yellow dot with an 
exclamation point next to the name, then you have a hardware 
conflict.

Review the IRQs and I/O addresses used by the other add-in cards 
to determine where the conflict is occurring. If you change the 1505 
card settings, remember to change the BIOS and software settings 
to match, as described in the preceding sections. After each change, 
check the Device Manager again until you resolve the conflict.
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Configure the 
Termination 
Resistors

If an Activator is sharing a 1505 card with other SCSI devices, the 
devices must be terminated properly. Refer to the “Terminating the 
SCSI Bus Cable” section in the Adaptec AVA-1505 AT-to-SCSI Host 
Adapter Installation Guide for information about terminating SCSI 
devices.

If you do not have other SCSI devices connected to the 1505 card, the 
termination resistors do not need to be changed.

Connect the 
Activator to the 
1505 Card 

Once you have installed the 1505 card, you must connect the Activator 
to your PC through the 1505 card. Go to “Connecting an Adaptec SCSI 
Card to the Activator” on page 16 for the procedure.

Installing the 1505 Card Under Windows NT
This section describes how to install the 1505 card under Windows NT.

Select a Unique 
IRQ and I/O 
Address

The default settings on the 1505 card should work, However, you may 
have an add-in card installed on you PC with IRQ and I/O address 
settings that conflict with the default settings on the 1505 card. The 
conflict may affect your video, network connection, or hard drive. If 
there is a conflict, you must change the IRQ and I/O address of either 
the 1505 card or an installed add-in card.

To select the IRQ and I/O address for the 1505 card:

1. Open the Windows NT Diagnostics Window. Choose Windows 
NT Diagnostics from the Administrative Tools (Common) menu in 
the Programs menu.

2. Determine what IRQs and I/O addresses are in use by 
installed add-in card(s). Click the Resources tab. The Resources 
window is displayed. Click the IRQ button to display the interrupts 
being used. Click the I/O Port button to display the addresses being 
used.
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3. Set the IRQ and I/O address for the 1505 card. The default 
interrupt number is IRQ11, but can be set from IRQ9 to IRQ12. The 
default I/O address is 340h-35Fh, but can be set to 140h-15Fh. Refer 
to the “Jumper Block Settings” section in the Adaptec AVA-1505 AT-
to-SCSI Host Adapter Installation Guide for information about 
changing the IRQ and I/O address on the 1505 card.

If all the interrupts between IRQ9 and IRQ12 are being used, you 
must change the IRQ settings on another card to free up one of 
these interrupts for the 1505 card.

Install the SCSI 
Board Into your 
PC

Turn off your computer, remove its cover, and install the 1505 card 
into an ISA expansion slot in the PC. After installing the card, replace 
the cover and turn the PC on. Refer to the “Inserting the Board” section 
in the Adaptec AVA-1505 AT-to-SCSI Host Adapter Installation Guide for 
additional information about installing the 1505 card.

Configure the 
Selected IRQ to 
Use the ISA Bus

If your computer is a Pentium PC with a PCI bus, you must change the 
CMOS setup in your BIOS so that the IRQ used by the 1505 card 
accesses the ISA bus rather than the PCI bus. You can usually change 
the BIOS setup during boot-up. Refer to the documentation provided 
by your computer or BIOS manufacturer for information about 
changing your BIOS setup.

If you don’t know if your Pentium uses a PCI bus, refer to the 
documentation provided by your computer manufacturer or contact 
your computer manufacturer.

IMPORTANT: If your computer uses the PCI bus and you do not change your BIOS, 
even if you have no hardware conflicts, the Activator will not work.

Note: If you remove the 1505 card from your PC, change the BIOS 
settings for that IRQ back to PCI bus use.
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Install the 
Windows NT 
Driver 

After installing and configuring the 1505 card, you must install two 
drivers under Windows NT. The first driver is provided by Microsoft. 
The second driver is provided by Actel. Go to “Install the Software 
Driver” on page 15 for installation instructions for the Actel driver.

To install the Windows NT driver:

1. Open the Add SCSI Adapters window. Double-click the SCSI 
Adapters icon located in the Control Panel program group.

2. Add the 1505 card driver. Click the Drivers tab. The Drivers 
window is displayed. Choose “Adaptec AIC-6X60 ISA Single-Chip 
SCSI Controller” from the list of devices. Put the Windows NT 4.0 
CD-ROM into the drive and Click OK. The NT driver is installed.

3. Re-boot the PC. You must re-boot for this driver to take effect.

To verify that the Windows NT driver is installed correctly:

1. Open the Add SCSI Adapters window. Double-click the SCSI 
Adapters icon located in the Control Panel program group.

2. View the 1505 care properties. Click the Drivers tab. The Drivers 
window is displayed. Look for the “Adaptec AIC-6X60 ISA Single-
Chip SCSI Controller” driver. Its status should be “Started.”

If there is a yellow dot with an exclamation point next to the driver 
name, then you have a hardware conflict. Review the IRQs and I/O 
addresses used by the other add-in cards to determine where the 
conflict is occurring. If you change the 1505 card settings, remember to 
change the BIOS and software settings to match, as described in the 
preceding sections. After each change, check the Device Manager 
again until you resolve the conflict.
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Install the 
Software Driver

In addition to the Windows NT driver, you must install the Adaptec 
ASPI driver provided by Actel.

To install the Adaptec ASPI driver:

Insert the Designer Series CD-ROM into the drive and execute the 
following program on the CD-ROM:

\ASPI_NT\ASPIINST.EXE 

After installation your computer will re-boot.

To verify that the software driver is configured properly:

Double-click the Devices icon located in the Control Panel program 
group. Look for the “Aspi32” driver. Its status should be “Started” and 
“Automatic.”

Configure the 
Termination 
Resistors

If an Activator is sharing a 1505 card with other SCSI devices, the 
devices must be terminated properly. Refer to the “Terminating the 
SCSI Bus Cable” section in the Adaptec AVA-1505 AT-to-SCSI Host 
Adapter Installation Guide for information about terminating SCSI 
devices.

If you do not have other SCSI devices connected to the 1505 card, the 
termination resistors do not need to be changed.

Connect the 
Activator to the 
1505 Card 

Once you have installed the 1505 card, you must connect the Activator 
to your PC through the 1505 card, as described on page 16.
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Connecting an Adaptec SCSI Card to the Activator
You can only use an Adaptec SCSI card with an Activator 2 or 2s. If 
you have an existing Adaptec SCSI card installed, you can use it 
instead of the 1505 card to interface with an Activator.

To connect a SCSI card to an Activator:

Connect the SCSI card to the Activator using the appropriate SCSI cable 
for the board’s external SCSI connector and the Activator 2 or 2s 
connector (female DB50 for Activator 2, DB25 for Activator 2s).

IMPORTANT: Activators contain termination resistors and must be the last device in 
the SCSI chain.

If SCSI ID number 5 is not available on your SCSI bus, set the rotary 
switch on the back of your Activator to an available SCSI ID, and 
modify the “Windows Programming” icon in the Designer Series 
Program Group using the following procedure:

1. Open the Designer Series program group. Right-click the Start 
button and select the Open All Users command (Open command 
for Windows 95). Double-click the Programs icon. Double-click the 
Designer Series icon.

2. Modify the Windows Programming icon. Click the Windows 
Programming icon. Choose the Properties command from the File 
menu. Click the Shortcut tab. Type the following in the Target box:

c:\actel\bin\apsw.exe devactivator2:4

The “4” represents the SCSI ID you want to set the Activator to use.
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Installing the Activator
The following procedure describes how to install an Activator 2 or 2s 
on a PC:

1. Turn off the PC.

2. Verify that the Activator power switch is OFF. See Figure 1-1 on 
page 2 or Figure 1-2 on page 3 for the location of the power 
switches.

3. Verify that the SCSI rotary switch is set to an available ID. The 
location of this switch is shown in Figure 1-1 on page 2 or Figure 
1-2 on page 3. The default ID is 5. refer to “Connecting an Adaptec 
SCSI Card to the Activator” on page 16 for information about 
changing the SCSI ID.

4. Connect the Activator to the PC using the supplied cable. 
Connect one end of the cable to the SCSI connector on the Activator 
rear panel (you can use either connector on the Activator 2) and 
tighten the locking screws. Connect the other end of the cable to 
the 1505 card in the PC and tighten the locking screws. The 
Activator is terminated internally and must be the last device on the 
SCSI chain. See Figure 2-1 for the location of the SCSI connectors.

CAUTION: The SCSI connector on the 1505 card is a female DB25 that can be 
confused with a parallel port connector. Make sure you plug the 
cable into the 1505 card or you could damage the connectors. 

5. Connect power to the Activator.

Activator 2

Insert the power cord into the power connector located on the rear 
panel and plug the other end into an AC power outlet.

Activator 2s

Insert the 8-pin DIN connector from the power supply into the DIN 
power jack located on the rear panel. Connect an AC power cord 
to the power supply and plug the other end into an AC power 
outlet (Figure 2-2).
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Note: The power supplies are rated for 100–240 VAC at 50 or 60 Hz. 
The Activator 2s power switch will remotely power down the 
power supply. Only a small voltage will remain to detect 
power up.

6. Turn on the Activator power. After a brief delay, the green power 
light should turn on and remain on continuously as long as the 
power is turned on.

7. Turn on the PC. You are now ready to program a device using 
APSW. Refer to chapter 4, “Programming an Actel Device” on page 
29 for information about programming a device.

Figure 2-1. Activator 2 and 2s PC Connections
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Figure 2-2. Power Supply Connected to Activator 2s
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Verifying 
Hardware 
Installation (NT 
4.0)

Use the following procedure to verify that the Activator installed 
correctly:

1. Open the Devices window. Double-click the SCSI Adapters icon 
located in the Control Panel program group. The SCSI Adapters 
window is displayed. Click the Devices tab to display the Devices 
window. 

2. View the 1505 card. Double click the “Adaptec AIC-6X60 ISA 
Single-Chip SCSI Controller” device driver. If eight unnamed tape 
drive icons appear, the Activator hardware installation was 
successful. If the icons do not appear, make sure the SCSI cable 
connection are correct, all cable connections are seated together 
firmly, and the power is connected properly and is turned on. Also 
make sure the SCSI ID rotary switch on the Activator is set to an 
available ID and matches what is set in the Windows Programming 
icon.

Installing and Removing an Adapter Module
The following procedure describes how to install an Adapter Module 
into and remove an Adapter Module from an Activator.

To install an Adapter Module:

1. Position the two metal guides on the Adapter Module into the 
corresponding slots on the Activator.

2. Press down on the Adapter Module to seat the connector 
firmly on the bottom of the module. Do not force the Adapter 
Module, it should fit easily. Be sure to keep the connector area 
clean.

To remove an Adapter Module:

1. Pull the top of the Adapter Module toward you until the 
connector comes free. Indentations are provided on the Adapter 
Module to facilitate this step.

2. Slide the Adapter Module upward to free the two metal 
guides.
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3
Hardware Installation on a Workstation

This chapter contains information and procedures to install an 
Activator 2 or 2s on a workstation running SunOS, Solaris, or HP-UX. 
This includes information about creating a link to an Activator.

Installing an Activator on a SunOS Workstation
The following procedure describes how to install an Activator 2 or 2s 
on a SunOS workstation:

1. Shutdown, then power down the workstation. When shutting 
the system down, turn off power to the workstation before turning 
off power to the Activator.

WARNING: Do not connect SCSI cables to the Activator while the workstation 
or other peripherals are turned on; data loss may result.

2. Verify that the Activator is OFF. See Figure 1-1 on page 2 or 
Figure 1-2 on page 3 for the location of the power switches.

3. Set the position of the SCSI rotary switch. The location of this 
switch is shown in Figure 1-1 on page 2 or Figure 1-2 on page 3. If 
you want to map the Activator to “rst1,” set the rotary switch to 
position 5. If you want to map the Activator to device “rst0,” set the 
rotary switch to position 4.

4. Connect the Activator to the workstation using the supplied 
SCSI cable. Connect one end of the cable to a SCSI connector on 
the Activator rear panel (you can use either connector on the 
Activator 2) and tighten the locking screws. Connect the other end 
of the cable to the SCSI connector of the workstation and tighten 
the locking screws or make sure the micro-miniature SCSI 
connector has snapped into place. See Figure 3-1 on page 22 for 
the location of the SCSI connectors.

The Activator is terminated internally. If several devices are daisy-
chained to the SCSI port, it must be the last device in the chain.

Note: Daisy chaining may require a cable with a different type of 
connector. The Activator SCSI cable is a standard cable with 
no scrambling. However, other connector combinations can 
be purchased. The cable length must not exceed 6 feet.
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5. Connect power to the Activator.

Activator 2

Insert the power cord into the power connector located on the rear 
panel and plug the other end into an AC power outlet.

Activator 2s

Insert the 8-pin DIN connector from the power supply into the DIN 
power jack located on the rear panel. Connect an AC power cord 
to the power supply and plug the other end into an AC power 
outlet (see Figure 2-2 on page 18).

Note: The power supplies are rated for 100–240 VAC at 50 or 60 Hz. 
The Activator 2s power switch will remotely power down the 
power supply. Only a small voltage will remain to detect 
power up.

6. Turn on the Activator power. After a brief delay, the green power 
light should turn on and remain on continuously as long as the 
power is on.

7. Power up the Workstation.

You must create a link to the Activator to complete installation. Go to 
“Creating a Link to the Activator” on page 23 for the procedure.

Figure 3-1. Activator 2 and 2s Workstation Connections
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Creating a Link 
to the Activator

Once you have installed the Activator on the workstation, you must 
create a symbolic link to the Activator to complete installation. Use the 
following procedure to create a symbolic link:

1. Log in as ROOT.

2. Create a symbolic link to the Activator. To map the Activator to 
“rst1,” verify that the Activator SCSI rotary switch is set to position 
5 and type the following command at the prompt:

ln -s /dev/rst1 /dev/activator2

Note: Because “rst0” is usually used for a tape drive or another 
storage unit, the Activator SCSI rotary switch is by default set 
to position 5 for use with “rst1.”

To map the Activator to “rst0,” verify that the Activator SCSI rotary 
switch is set to position 4 and type the following command at the 
prompt:

ln -s /dev/rst0 /dev/activator2

You are now ready to program a device using APSW. Refer to chapter 
4, “Programming an Actel Device” on page 29 for information about 
programming a device.

Installing an Activator on a Solaris Workstation
The following procedure describes how to install an Activator 2 or 2s 
on a Solaris workstation:

1. Shutdown, then power down the workstation. When shutting 
the system down, turn off power to the workstation before turning 
off power to the Activator.

WARNING: Do not connect SCSI cables to the Activator while the workstation 
or other peripherals are turned on; data loss may result.

2. Verify that the Activator is OFF. See Figure 1-1 on page 2 or 
Figure 1-2 on page 3 for the location of the power switches.
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3. Set the position of the SCSI rotary switch. The location of this 
switch is shown in Figure 1-1 on page 2 or Figure 1-2 on page 3. 
The switch is set to position 5 by default, but it must be set to 
another position. Actel recommends setting it to position 3 or 4. The 
switch settings correspond to device files, which may require a 
system administrator to create.

4. Connect the Activator to the workstation using the supplied 
SCSI cable. Connect one end of the cable to a SCSI connector on 
the Activator rear panel (you can use either connector on the 
Activator 2) and tighten the locking screws. Connect the other end 
of the cable to the SCSI connector of the workstation and tighten 
the locking screws or make sure the micro-miniature SCSI 
connector has snapped into place. See Figure 3-1 on page 22 for 
the location of the SCSI connectors.

The Activator is terminated internally. If several devices are daisy-
chained to the SCSI port, it must be the last device in the chain.

Note: Daisy chaining may require a cable with a different type of 
connector. The Activator SCSI cable is a standard cable with 
no scrambling. However, other connector combinations can 
be purchased. The cable length must not exceed 6 feet.

5. Connect power to the Activator.

Activator 2

Insert the power cord into the power connector located on the rear 
panel and plug the other end into an AC power outlet.

Activator 2s

Insert the 8-pin DIN connector from the power supply into the DIN 
power jack located on the rear panel. Connect an AC power cord 
to the power supply and plug the other end into an AC power 
outlet (see Figure 2-2 on page 18).

Note: The power supplies are rated for 100–240 VAC at 50 or 60 Hz. 
The Activator 2s power switch will remotely power down the 
power supply. Only a small voltage will remain to detect 
power up.
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6. Turn on the Activator power. After a brief delay, the green power 
light should turn on and remain on continuously as long as the 
power is on.

7. Power up the workstation.

8. Interrupt the boot sequence. On a Type 4 keyboard, press the 
“L1” and “A” keys simultaneously. On a type 5 keyboard, press the 
“Stop” and “A” keys simultaneously.

9. Initiate a reconfiguration boot. Type “boot -r” at the ok prompt.

10. Verify that the Activator driver is installed. After the system 
boots, check the “/dev/rmt” directory. You should see multiple tape 
devices called “0mn,” “0m,” etc.

11. Create a link to the Activator.

You must create a link to the Activator to complete installation. Go to 
“Creating a Link to the Activator” below for the procedure.

Creating a Link 
to the Activator

Once you have installed the Activator on the workstation, you must 
create a symbolic link to the Activator to complete installation. Use the 
following procedure to create a symbolic link:

1. Log in as ROOT.

2. Create a symbolic link to the Activator. Type the following 
command at the prompt:

ln -s <device_file> /dev/activator2

For example, if you have set the SCSI rotary switch to position 3, 
verify the device file “/dev/rmt/3mn” exists, then create a symbolic 
link as follows:

ln -s /dev/rmt/3mn /dev/activator2

If “/dev/rmt/3mn” does not exist, or if you don’t know which SCSI 
ID to set the rotary switch to, contact your system administrator for 
help.

You are now ready to program a device using APSW. Refer to chapter 
4, “Programming an Actel Device” on page 29 for information about 
programming a device.
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Installing an Activator on an HP-UX Workstation
The following procedure describes how to install an Activator 2 or 2s 
on an HP-UX workstation:

1. Shutdown, then power down the workstation. When shutting 
the system down, turn off power to the workstation before turning 
off power to the Activator.

WARNING: Do not connect SCSI cables to the Activator while the workstation 
or other peripherals are turned on; data loss may result.

2. Verify that the Activator is OFF. See Figure 1-1 on page 2 or 
Figure 1-2 on page 3 for the location of the power switches.

3. Set the position of the SCSI rotary switch. The location of this 
switch is shown in Figure 1-1 on page 2 or Figure 1-2 on page 3. 
The switch is set to position 5 by default, but it must be set to 
another position. Actel recommends setting it to position 3 or 4. The 
switch settings correspond to device files, which may require a 
system administrator to create.

4. Connect the Activator to the workstation using the supplied 
SCSI cable. Connect one end of the cable to a SCSI connector on 
the Activator rear panel (you can use either connector on the 
Activator 2) and tighten the locking screws. Connect the other end 
of the cable to the SCSI connector of the workstation and tighten 
the locking screws or make sure the micro-miniature SCSI 
connector has snapped into place. See Figure 3-1 on page 22 for 
the location of the SCSI connectors.

The Activator is terminated internally. If several devices are daisy-
chained to the SCSI port, it must be the last device in the chain.

Note: Daisy chaining may require a cable with a different type of 
connector. The Activator SCSI cable is a standard cable with 
no scrambling. However, other connector combinations can 
be purchased. The cable length must not exceed 6 feet.
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5. Connect power to the Activator.

Activator 2

Insert the power cord into the power connector located on the rear 
panel and plug the other end into an AC power outlet.

Activator 2s

Insert the 8-pin DIN connector from the power supply into the DIN 
power jack located on the rear panel. Connect an AC power cord 
to the power supply and plug the other end into an AC power 
outlet (see Figure 2-2 on page 18).

Note: The power supplies are rated for 100–240 VAC at 50 or 60 Hz. 
The Activator 2s power switch will remotely power down the 
power supply. Only a small voltage will remain to detect 
power up.

6. Turn on the Activator power. After a brief delay, the green power 
light should turn on and remain on continuously as long as the 
power is on.

7. Power up the workstation.

You must create a link to the Activator to complete installation. Go to 
“Creating a Link to the Activator” below for the procedure.

Creating a Link 
to the Activator

Once you have installed the Activator on the workstation, you must 
create a symbolic link to the Activator to complete installation. Use the 
following procedure to create a symbolic link:

1. Log in as ROOT.

2. Create a symbolic link to the Activator. Type the following 
command at the prompt:

ln -s <device_file> /dev/activator2

For example, if you have set the SCSI rotary switch to position 3, 
verify the device file “/dev/rmt/3mn” exists, then create a symbolic 
link as follows:

ln -s /dev/rmt/3mn /dev/activator2
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If “/dev/rmt/3mn” does not exist, or if you don’t know which SCSI 
ID to set the rotary switch to, contact your system administrator for 
help.

You are now ready to program a device using APSW. Refer to chapter 
4, “Programming an Actel Device” on page 29 for information about 
programming a device.

Installing and Removing an Adapter Module
The following procedure describes how to install an Adapter Module 
into and remove an Adapter Module from an Activator.

To install an Adapter Module:

1. Position the two metal guides on the Adapter Module into the 
corresponding slots on the Activator programmer.

2. Press down on the Adapter Module to seat the connector 
firmly on the bottom of the module. Do not force the Adapter 
Module, it should fit easily. Be sure to keep the connector area 
clean.

To remove an Adapter Module:

1. Pull the top of the Adapter Module toward you until the 
connector comes free. Indentations are provided on the Adapter 
Module to facilitate this step.

2. Slide the Adapter Module upward to free the two metal 
guides.
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4
Programming an Actel Device

This chapter discusses the recommended programming flow and 
describes the procedure for programming an Actel device using an 
Activator connected to a PC or workstation and the APSW 
programming software.

Programming Flow
The recommended programming flow for an Actel device has two 
steps: program a device, and save the AVI file. These steps are 
described in the following sections.

Program a 
Device

Use an Activator to program your device. Make sure you follow ESD 
device handling procedures when removing a device from its 
packaging and when placing it into an Activator. Refer to “Device 
Handling” on page 1 and “Removing a Device from the Carrying Case” 
on page 34 for information about handling and unpacking Actel 
devices.

Save the AVI 
File

Once you have programmed your device, save your AVI file. When 
you program a chip, the programming history is saved in the 
<design_name>.avi file. The AVI file contains programming data for 
each antifuse programmed, including the number of programming 
pulses applied and fuse current readings. This file is overwritten each 
time you select the Activate command. Refer to Appendix C, “AVI File 
Description” on page 79 for information about the AVI file. 

If your device fails to program, refer to Chapter 5, “Device 
Programming Failure Guidelines” on page 43 for information about 
programming failures and maximum allowed programming failure 
guidelines.
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APSW Description
This section describes the APSW interface including information about 
using the interface to program Actel devices. Figure 4-1 shows the 
main window for APSW.

Open The Open button or menu command opens a programming file.

To open a programming file:

Click the Open button or choose the Open command from the File 
menu. The Open dialog box is displayed. Type in the design name or 
browse to the directory that contains the <design_name>.adb (or .afm) 
file and select it. Click OK.

Figure 4-1. APSW Main Window
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Activate The Activate button or menu command is used to program a device. 
Refer to “Programming a Device” on page 35 for detailed information 
about using the Activate command to program an Actel device.

Blankcheck The Blankcheck button or menu command executes a test to 
determine if a device has already been programmed. Blankcheck 
displays a report for each Activator socket that has an adapter module 
plugged into it (the Activator 2S only has one socket). Blankcheck is 
performed automatically before the chip is programmed whenever the 
Activate command is used.

The result of executing Blankcheck is either “blank” or “not blank” 
followed by the Silicon Signature, Checksum, and Security Fuse status 
read from the device. Only blank devices of the correct type 
(according to the design parameters) result in a blank status. A Security 
Fuse status of 0 indicates that the security fuse has not been 
programmed; a 1 indicates that the security fuse has been 
programmed.

To run Blankcheck:

Click the Blankcheck button, or choose the Blankcheck command 
from the Tools menu. 

Checksum The Checksum button or menu command verifies that the current 
programming file is the same one that was used to program the device. 
The Checksum command compares the checksum number, computed 
from the programming file, to the checksum number programmed into 
the chip. If the two numbers are the same, APSW displays “PASSED.” If 
the two numbers are not the same, the program displays “FAILED,” 
with additional comments to briefly explain why it failed.

Note: If you have already programmed the Probe fuse on an ACT 1 
device, you cannot read the Checksum from the device.

To run Checksum:

Click the Checksum button, or choose the Checksum command from 
the Tools menu. The checksum number is displayed in the APSW 
window, along with a “Passed” or “Failed” message. If Checksum fails, 
a message is displayed that describes why it failed.
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Action Probe The Action Probe button or menu command initializes the Action 
Probe software and opens the Explore window for debugging a 
programmed device using the Actel Silicon Explorer diagnostic tool. 
The Silicon Explorer allow you to probe the internal signals of the 
device while it operates in your system. Refer to Chapter 7, “Silicon 
Explorer Diagnostic Tool” on page 57 for information.

To run Action Probe:

Click the Action Probe button, or choose the Action Probe command 
from the Tools menu.

Note: If you have already programmed the Probe fuse on an ACT 1 or 
40MX device or the Security fuse on any other Actel device, you 
cannot use the Action Probe software to debug the device.

Debugger The Debugger button or menu command initializes the Debugger test 
environment. The Debugger environment allows you to test a 
programmed device before you place it in your system circuit. With 
Debugger, you can probe the chips internal nodes by applying 
stimulus through an Activator. Debugger commands are entered 
through the Command box located at the top of the APSW window. If 
the Action Probe software has already been initialized, Debugger is 
also initialized and available for use. When you use Debugger with an 
Activator 2s, APSW recognizes the Adapter Module as port 4. Refer to 
Chapter 7, “Debugging a Device with an Activator” on page 45 for 
information about using Debugger.

To run Debugger:

Click the Debugger button, or choose the Debugger command from 
the Tools menu.

Note: If you have already programmed the Probe fuse on an ACT 1 or 
40MX device or the Security fuse on any other Actel device, you 
cannot use the Action Probe software to debug the device.
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Command Box The Command box is used to enter Debugger command-line 
commands. Refer to “Debugger Command-Line Commands” on page 
47 for information.

Programming a Device with APSW
This section contains information about programming files and 
describes the procedure for programming an Actel device with APSW.

Supported 
Device Files

To program devices with APSW, you must have an Actel programming 
file. APSW can read the following programming file types:

• Actel database file (ADB) for a design that has a completed layout

• Actel programming file (AFM) exported from Designer using the Fuse 
command

• FUS and DEF files produced from pre-Designer 3.0 software

Note: If Layout has been completed in Designer, you do not need to 
execute the Fuse command. APSW automatically extracts 
programming information from the ADB file.

User-Defined 
Silicon 
Signature

To specify a user-defined Silicon Signature to be programmed into a 
device, enter the signature from within Designer using one of the 
following methods:

1. Create an AFM file containing a Silicon Signature. Select the 
Fuse command, enter the Silicon Signature, then export the .afm 
file. Refer to the Design with Actel manual for information about 
how to use the Fuse command to generate an AFM file.

2. Set the SIG variable. Choose Set from the Options menu, and 
enter the desired value.

Note: The Silicon Signature must be a hexadecimal number, no 
more than 5 digits long.
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Removing a 
Device from 
the Carrying 
Case

Use the following ESD procedure to remove an Actel device from the 
insulative individual carrying case before placing it in an Adapter 
Module.

IMPORTANT: You should always wear a grounded wrist strap at an ESD workstation 
when handling Actel devices. A calibrated ionizer should be on and 
functioning properly at the workstation. An ionizer air stream should 
be directed over the devices at all times. 

1. Slowly remove the individual carrying case from the carrier 
box. The individual carrying case may build a charge while being 
removed from the foam in the carrier box.

2. Ionize the individual carrying case. Hold the individual carrying 
case approximately three feet from the ionizer. Expose each side of 
the case to the air stream for 30 to 60 seconds.

3. Remove the device from the individual carrying case. Open 
the case, remove the device and place the device on top of ESD 
sensitive foam.

The device can now be placed in the Adapter Module or repackaged 
in a static dissipative container.

Programming 
Checklist

Before executing any commands in APSW, verify the following:

1. The Activator is powered on and the green LED is lit.

2. The appropriate Adapter Module(s) is plugged into the socket(s) on 
the Activator.

3. A device is inserted in the Adapter Module, with pin 1 oriented as 
indicated in the diagram printed on the Adapter Module.

Note: Insert a device into the Adapter Module socket after the 
Module is plugged in and the Activator is powered up.
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Programming a 
Device

Programming typically requires from 5 to 15 minutes for commercial 
and RadTolerant devices and 30 to 60 minutes for RadHard devices, 
depending on design complexity, the Actel device you have chosen, 
and your system environment. During programming, the Activator 
dynamically verifies that each antifuse is programmed correctly. In 
addition, test vectors are applied to verify that only the selected 
antifuses are programmed. Due to the unique, high-density 
architecture of Actel devices, you can verify the programmed state of 
all antifuses only during programming, not after. The following 
procedure describes how to program a device.

1. Invoke APSW.

Workstation

Type the following command at the prompt:

apsw

PC

Double click the “Windows Programming” icon located in the 
Designer Series program group.

The APSW window is displayed (see Figure 4-1).

2. Open your design. Click the Open button or choose the Open 
command from the File menu. The Open dialog box is displayed. 
Type in the design name or browse to the directory that contains 
the <design_name>.adb (or .afm) file and select it. Click OK.

3. Choose fuse programming options. Click the Activate button or 
choose the Activate command from the Tools menu. The Activate 
Options dialog box is displayed.

4. Program your device. You can program Array fuses only, the 
Security fuse(s) only, or both Array fuses and the Security fuse(s). 
For ACT 1 and 40MX devices, the dialog box shown in Figure 4-2 
is displayed. For all other devices, the dialog box shown in Figure 
4-3 is displayed. Choose the desired fuse programming options and 
click OK. Refer to “Programming Security Fuses” on page 36 for a 
discussion about programming security fuses.
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IMPORTANT: The Program or Security fuse must be the last fuse programmed.

An Output Window is displayed on the screen and the 
programming sequence begins. The status bar in the Output 
Window displays the percentage complete of the programming 
sequence. When the device is 100% programmed, the finished 
programming status “Passed” or “Failed” is displayed in the 
window.

5. Save the AVI file. Exit APSW and move or rename the AVI file for 
the design. The AVI file is written to the same directory as your 
programming file. Refer to Appendix C, “AVI File Description” on 
page 79 for information about AVI files.

Programming Security Fuses
You can program the Security fuse(s) on an Actel device that has had 
its Array fuses previously programmed. The ability to program the 
Security fuse(s) after programming Array fuses is designed to allow 
you to debug your device design with the Debugger or Silicon 
Explorer diagnostic tool. After you debug your design, you can 
program the Security fuses to secure the device from further probing.

Figure 4-2. Activate Options for 
ACT 1 and 40MX Devices

Figure 4-3. Activate Options for all 
Other Devices
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ACT 1 and 
40MX Security 
Fuse 
Configurations

The ACT 1 devices contain two security fuses: Probe and Program. 
Programming the Probe fuse disables the Probe Circuitry, which 
disables the use of the Debugger and Silicon Explorer diagnostic tools. 
Programming the Program fuse prevents further programming of the 
device, including programming the Probe fuse. Table 4-1 summarizes 
the effects of programming the Security fuses on the PRA, PRB, SDI, 
and DCLK pins.

In the normal operating mode (MODE=0), all undefined device pins in 
a design are automatically configured as active LOW outputs. 

Two exceptions are the SDI and DCLK pins. If the Program fuse is not 
programmed and SDI and DCLK are undefined, they are configured as 
inactive inputs. In this case, SDI and DCLK pins should be tied to 

Table 4-1. ACT 1 and 40MX Security Fuse Configurations

Mode1 Program Probe PRA, PRB SDI, DCLK

low no no user-defined I/O
user-defined 
input2

low no yes3 user-defined I/O
user-defined 
input2

low yes4 no user-defined I/O
user-defined
I/O

low yes4 yes3 user-defined I/O
user-defined
I/O

high no no Probe Circuit outputs5 Probe Circuit 
inputs6

high no yes3 Probe Circuit disabled
Probe Circuit 
disabled

high yes4 no Probe Circuit outputs5 Probe Circuit 
inputs6

high yes4 yes3 Probe Circuit disabled
Probe Circuit 
disabled
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ground. If the Program fuse is programmed and SDI and DCLK are 
undefined, they will become active LOW outputs.

Legend for Table 4-1
1. The MODE pin switches the device between the normal operating 

mode (MODE=0) and the Probe Circuit mode (MODE=1).

2. The Program fuse must be programmed if the SDI or DCLK pins are 
to be used as an output or a bi-directional pin.

3. If the Probe fuse is programmed, the Probe Circuit is permanently 
disabled, which disables the Debugger and Silicon Explorer 
diagnostic tools.

4. If the Program fuse is programmed, all programming of the device 
is disabled, including programming the array fuses and the Probe 
fuse.

5. The PRA output and a separate I/O buffer share the use of a single 
device pin. The PRA output and the output function of the I/O 
buffer are multiplexed. The same is true for PRB. The Probe Mode 
that is loaded into the Mode Register will determine which output 
buffer is active during probing. There are three possible Probe 
Modes: “PRA only,” “PRB only,” and “PRA and PRB.”

When the “PRA only” mode is selected, the PRA output becomes 
active and the output function of the I/O buffer associated with the 
PRA pin is inhibited. However, the input buffer portion of the I/O 
buffer associated with the PRA pin is still active. Any internal signal 
that appears on the PRA output is fed back through that input buffer 
to the internal Logic Modules. This could interfere with the 
expected function of the design during probing. Actel recommends 
that you use an input latch on PRA and PRB to prevent the feedback 
while probing. PRB will function as a normal I/O in the “PRA only” 
mode.

The “PRB only” mode is functionally equivalent to the “PRA only” 
mode. PRA also functions as a normal user I/O in the “PRB only” 
mode.

When the “PRA and PRB” mode is selected, both the PRA and PRB 
outputs become active and the output function of the I/O buffers 
associated with both pins are inhibited. However, the input buffer 
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of the I/O buffers associated with both pins are still active. Any 
internal signals that appear on the PRA and PRB outputs are fed 
back through the input buffers to the internal Logic Modules. This 
could interfere with the expected function of the design while 
probing. Actel recommends that you use an input latch on PRA and 
PRB to prevent the feedback during probing.

6. The SDI input and a separate I/O buffer share the use of a single 
device pin. The SDI input and the input function of the I/O buffer 
are connected in parallel. When the Mode pin is high, both inputs 
are active. The same is true for DCLK. External Probe Circuit control 
signals sent to those pins are also sent to the internal Logic 
Modules. This could interfere with the expected function of the 
design while probing. Actel recommends that you use an input 
latch on SDI and DCLK to prevent the external Probe Circuit control 
signals from effecting the functionality of your design during 
probing.

If either SDI or DCLK are configured so that the output function of 
the I/O buffer is active, the Program fuse must be programmed. In 
this configuration, the signals from your design are fed back to the 
Shift Register and will interfere with the function of the Probe 
Circuitry. In addition, the I/O drivers will conflict the external SDI 
and DCLK drivers. Damage to both drivers could occur.

Non-ACT 1/
40MX Security 
Fuse 
Configurations

All Actel devices other than ACT 1and 40MX devices contain one 
Security fuse. Programming the Security fuse disables the Probe 
Circuitry, which disables the use of the Debugger and Silicon Explorer 
diagnostic tools. Table 4-2 summarizes the effect or programming the 
security fuse on the PRA, PRB, SDI, and DCLK pins.

Table 4-2. Non ACT 1/40MX Security Fuse Configurations

Mode1 Security PRA, PRB SDI, DCLK

low don't care user-defined I/O user-defined I/O

high no Probe Circuit outputs3 Probe Circuit inputs4

high yes2 Probe Circuit disabled Probe Circuit disabled
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In the normal operating mode (MODE=0), all undefined device pins in 
a design are automatically configured as active LOW outputs. You do 
not need to program the Security fuse to enable SDI and DCLK as 
active LOW outputs.

Legend for Table 4-2
1. The MODE pin switches the device between the normal operating 

mode (MODE=0) and the Probe Circuit mode (MODE=1).

2. If the Security fuse is programmed, the Probe Circuit is permanently 
disabled which disables the Debugger and Silcon Explorer 
diagnostic tools.

3. The PRA output and a separate I/O buffer share the use of a single 
device pin. The PRA output and the output function of the I/O 
buffer are multiplexed. The same is true for PRB. The Probe Mode 
that is loaded into the Mode Register will determine which output 
buffer is active during probing. There are three possible Probe 
Modes: “PRA only,” “PRB only,” and “PRA and PRB.”

When the “PRA only” mode is selected, the PRA output becomes 
active and the output function of the I/O buffer associated with the 
PRA pin is inhibited. However, the input buffer portion of the I/O 
buffer associated with the PRA pin is still active. Any internal signal 
that appears on the PRA output is fed back through that input buffer 
to the internal Logic Modules. This could interfere with the 
expected function of the design during probing. Actel recommends 
that you use an input latch on PRA and PRB to prevent the feedback 
while probing. PRB will function as a normal I/O in the “PRA only” 
mode.

The “PRB only” mode is functionally equivalent to the “PRA only” 
mode. PRA also functions as a normal user I/O in the “PRB only” 
mode.

When the “PRA and PRB” mode is selected, both the PRA and PRB 
outputs become active and the output function of the I/O buffers 
associated with both pins are inhibited. However, the input buffer 
of the I/O buffers associated with both pins are still active. Any 
internal signals that appear on the PRA and PRB outputs are fed 
back through the input buffers to the internal Logic Modules. This 
could interfere with the expected function of the design while 
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probing. Actel recommends that you use an input latch on PRA and 
PRB to prevent the feedback during probing. An input latch is an 
integral part of the I/O buffers in the RH1280 and A1280A devices.

4. The SDI input and a separate I/O buffer share the use of a single 
device pin. The SDI input and the input function of the I/O buffer 
are connected in parallel. When the Mode pin is high, both inputs 
are active. The same is true for DCLK. External Probe Circuit control 
signals sent to those pins are also sent to the internal Logic 
Modules. This could interfere with the expected function of the 
design while probing. Actel recommends that you use an input 
latch on SDI and DCLK to prevent the external Probe Circuit control 
signals from effecting the functionality of your design during 
probing. An input latch is an integral part of the I/O buffers in the 
RH1280 and A1280A devices.

The output function of the I/O buffers associated with SDI and 
DCLK do not interfere with the function of the Probe Circuitry while 
in the Probe Mode. When the Mode pin is driven high, these 
outputs are inhibited. The I/O drivers do not interfere with the 
external drivers. However, these outputs are not observable in the 
Probe Mode.
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5
Device Programming Failure Guidelines

This chapter contains programming failure guidelines, Activator failure 
guidelines, information about testing an Activator, and information 
about returning failed devices. Refer to Appendix A, “Troubleshooting” 
on page 71 for an explanation of programming failure error messages 
that may be displayed during programming of an Actel device.

Programming Failure Guidelines
Programming failures are a normal and expected result of antifuse-
based FPGA design. Actel performs extensive testing to measure the 
characteristics of the antifuses, and programs a sample of devices from 
every lot to ensure high programming results. However, Actel cannot 
guarantee that all devices will program successfully, and you should 
expect some programming failures.

The guaranteed quality and reliability of the devices that program 
successfully are unrelated to the programming yield. All devices that 
pass the programming function are fully guaranteed to meet all 
electrical, timing, and radiation specifications.

Device Failure 
Rates

Commercial devices typically exhibit a 1-2% programming failure rate. 
If programming failures exceed the guidelines listed in the following 
table, contact your local sales representative or the Actel Customer 
Application Center at 1-800-262-1060.

Sample Size Maximum Failures

13 3

31 5

63 8

100 10
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Activator Programming Failures
The Activators are designed to program all Actel devices. If you are 
experiencing a programming failure rate of greater than 2% for your 
devices, follow the steps below before returning the devices to Actel:

1. Check the SCSI interface and power cables to see if intermittent 
connections are occurring.

2. If you have access to another computer, try installing the Activator 
and programming software onto that computer, and programming 
devices to see if the yield improves.

3. If the yield problem still exists, the problem could be with the 
Activator. Call Actel’s Customer Applications Center at
1-800-262-1060 for further assistance.

Returning Failed Devices
If a device fails to program, you can take the following actions:

1. For normal device failure rates, return parts for replacement by 
requesting an RMA number through Actel’s sales representatives, 
distributors, or customer service.

2. For device failure rates greater than those specified earlier, call the 
Actel Customer Applications Center at 1-800-262-1060 with 
information concerning any problems observed. If needed, a failure 
analysis can be performed.
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6
Debugging a Device with an Activator

This chapter describes how to use the Debugger tool in APSW and an 
Activator to functionally debug your programmed Actel device. This 
includes descriptions of available debugging commands and command 
file usage and examples.

Functional Debugging with an Activator
Functional debugging of a device with the Debugger tool in APSW is 
done with a device placed in an Adapter Module and plugged into an 
Activator. Functional debugging is used to test a programmed device 
by applying a stimulus to the input pins and observing the functional 
behavior at all internal nodes or nets and output pins.

Functional debugging is not the same as simulating. A programmed 
chip is required. The output results are determined from the silicon 
device, not from a model stored in memory. Functional debugging can 
be performed two ways. You can apply stimulus to the input pins by 
executing command-line commands or by creating command files and 
reading the files into APSW.

If you execute command-line commands, each command is executed 
before the next command can be entered. After each command is 
executed, output results are printed on the screen, or to a file if 
specified. Refer to “Debugger Command-Line Commands” on page 47 
for a description of the command-line commands.

If you have a large number of commands to execute, you can create a 
command file. A command file contains a set of commands that are 
executed on your device. A command file can also contain input test 
vectors. If you provide expected outputs with a test vector file, 
Debugger compares the chip output results with the expected outputs 
automatically. The Debugger saves any differences it finds for further 
analysis. Debugger then prints the output results on the screen, or to a 
file if specified in the command file. Refer to “Using Command Files to 
Debug a Device” on page 51 for information about using command 
files.



Chapter 6: Debugging a Device with an Activator

46

Running Debugger From APSW
Use the following procedure to initialize Debugger and debug your 
device.

1. Invoke APSW.

Workstation

Type the following command at the prompt:

apsw

PC

Double click the “Windows Programming” icon in the Designer 
Series program group.

The APSW window is displayed (see Figure 4-1 on page 30).

2. Open the design to be debugged. Click the Open button or 
choose the Open command from the File menu. The Open dialog 
box is displayed. Type in the design name or browse to the 
directory that contains the “<design_name>.adb” (or .afm) file and 
select it. Click OK.

3. Verify that you have a programmed device placed in an 
Adapter Module plugged into the Activator. Click the 
Blankcheck button or choose the Blankcheck command from the 
Tools menu. If a “not blank” message is displayed, the device has 
been programmed.

4. Debug your device. Click the Debugger button to initialize the 
tool. The message “Debugger initialization complete” is displayed 
when the Debugger is finished loading. Execute single command-
line commands or load a command file using the loadfile command 
in the Command box. Refer to page 47 for information about 
command-line commands. Refer to “Using Command Files to 
Debug a Device” on page 51 for information about creating 
command files.
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Debugger Command-Line Commands
Command-line commands can be executed in APSW by typing the 
command in the Command box at the top of the APSW window and 
pressing Enter. Table 6-1 lists the command, syntax, and function of 
the command.

Table 6-1. Command-Line Commands and Functions 

Command Function

Assign

assign <n> <vector_1> ... <vector_n>

Assigns the value <n> to each electrical node, or vec-
tor of nodes, the next time you execute the Step
command. Each node must be a chip I/O or no 
assignment occurs. The format of <n> is as follows: 
0=decimal; 0b=binary; 0h=hexadecimal; 0o=octal; 
“01x2”=string. You can also assign a string-type
constant to a vector. Valid characters are 1, 0, Z, z, X, 
and x. The character must be enclosed in double 
quotation marks. For example: assign “1Zx0” IN.

Comp

comp <n> <vector_1> ... <vector_n>

Compares <n> to each node or vector, and prints a 
message for each node in the list whose value is not 
equal to <n>.

CompFile

compfile “<PATH\filename>”

Opens the specified file to be used with the Fcomp 
command. The argument must be enclosed in double 
quotes.

Debg Socket 

dbg-socket <n>

Chooses the socket on the Activator 2 to use during 
debug. The value of <n> can be 1, 2, 3, or 4. If only 1 
Adapter Module is plugged in, you do not need to 
use this command.
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Define Macro

define <name> <command> ... <command>

Defines a macro. When invoked, commands specified 
in the macro are executed.

Emit

emit “<example_text_string>”

Prints its argument to the screen and log file. The 
argument must be enclosed in double quotes.

Fassign

fassign <vector_1> ... <vector_n>

Reads the value <n> from the input file defined by 
the Infile command. Assigns the value <n> to each 
electrical vector the next time you use the Step
command. Each vector must be a chip I/O or no 
assignment occurs.

Fcomp

fcomp <vector_1> ... <vector_n>

Compares <n> to each node or vector, and prints a 
message for each node in the list whose value is not 
equal to <n>. The value checked is read from the 
next line in the file opened with the Compfile
command.

Fprint

fprint <vector_1> ... <vector_n>

Prints the current values of all nodes in the Tablist to 
the file opened with the Outfile command.

ICP

icp <internal_node_1> <internal_node_2>

Used for In-Circuit-Probing with an ActionProbe. It 
brings <internal_node_1> out to the probe A pin. The 
second argument is optional. If given, 
<internal_node_2> is brought out to the probe B pin.

Table 6-1. Command-Line Commands and Functions (Continued)

Command Function
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Infile

infile “<PATH/infile_name>”

Opens an input file used with the Fassign command. 
The argument must be enclosed in double quotes.

LoadFile

loadfile “<PATH/filename>”

Loads the specified command file and executes all 
the commands in the file. The PATH consists of the 
full path for the command file. All commands in the 
command file must be enclosed in parentheses. 

OutFile

outfile “<PATH/filename>”

Opens the specified file to be used with the Fprint 
command. The argument must be enclosed in double 
quotes.

Print

print <vector_1> ... <vector_n>

Prints the values of the specified vector(s). If no
vector is specified, the current values of all nodes in 
the Tablist are printed.

Repeat

repeat <n> <function>

Repeats a sequence for <n> cycles. The <function> 
can be a debugger command or a user-defined 
macro.

Step

step <n>

Debugs for <n> cycles. If <n> is not specified, a 
default of one cycle is used.

Table 6-1. Command-Line Commands and Functions (Continued)

Command Function
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Stimulus High

h <vector_1> ... <vector_n>

Assigns the value logical 1 to each electrical node or 
vector of nodes the next time you use the Step
command. Each node must be a chip I/O or no 
assignment occurs.

Stimulus High-Z

z <vector_1> ... <vector_n>

Sets all listed nodes to Z (high impedance) the next 
time you use the Step command. Each node must be 
a chip I/O or no assignment occurs.

Stimulus Low

l <vector_1> ... <vector_n>

Assigns the value logical 0 to each electrical node or 
vector of nodes the next time you use the Step
command. Each node must be a chip I/O or no 
assignment occurs.

TabAdd

tabadd <vector_1> ... <vector_n>

Adds the named nodes or vectors to the list of nodes 
printed with the Print command. Names can be 
dropped by recreating the list using the Tablist
command.

TabList

tablist <vector_1> ... <vector_n>

Initializes the Tablist to the specified nodes and
vectors. If no arguments are given, prints the current 
contents of the Tablist.

Vector

vector <name> <node list>

Defines a vector <name> whose elements are the 
listed nodes.

Table 6-1. Command-Line Commands and Functions (Continued)

Command Function
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Using Command Files to Debug a Device
A command file contains a series of Debugger command-line 
commands that when loaded into Debugger are automatically 
executed. Use command files to run a large number of command-line 
commands on your device during debug. 

To create a command file use a text editor or a word processor and 
save the file as ASCII text. Each command in the command file must be 
enclosed in parentheses. Use the loadfile command to load a 
command file into Debugger.

Two examples are shown to illustrate how to create and use command 
files to debug a device. Refer to “Debugger Command-Line 
Commands” on page 47 for information about the available command-
line commands.

Command File 
Example 1

The following example shows a command file followed by an 
explanation of the file, an input file, an output file, and a comparison 
file:

(vector P P0 P1 P2 P3 P4 P5 P6 P7)
(vector Q Q0 Q1 Q2 Q3 Q4 Q5 Q6 Q7)
(tabadd PE CEP CET UD P CLK Q TC)
(infile “/designs/example/example.pat”)
(outfile “/designs/example/example.out”)
(compfile “/designs/example/example.cmp”)
(define (clk10)(repeat 10(1 CLK)(step)(h CLK)(step)(fprint)
(fcomp Q))

(define (up) (1 CET CEP) (h PE UD)(step)(clk10))
(define (down) (h PE) (1 CEP CET UD)(step)(clk10))
(define (load) (1PE CLK) (fassign P)(step)(h CLK)(step))
(load)
(up)
(load)
(down)

The first “vector” command defines eight parallel load input bits as 
vector P. The second vector command defines counter outputs as 
vector Q.
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The “tabadd” command causes the signals PE, CEP, CET, UD, P, CLK, 
Q, and TC to be displayed or printed when the “print” or “fprint” 
command is executed.

The “infile” command defines and opens a file containing input test 
vectors (see “Example Input File” on page 52). The “outfile” command 
defines and opens a file for receiving Debugger output results (see 
“Example Output File” on page 53). The “compfile” command defines 
and opens a file containing the expected output values to be 
compared to the actual output values (see “Example Comparison File” 
on page 53).

The “define” commands create the following user macros:

clk10. The clk10 macro provides 10 clock pulses to the CLK input, 
prints all of the nodes specified in the tabadd command to the 
outfile, and compares the status of the vector Q to the expected 
results.

up. The up macro specifies the counter to count up for 10 cycles.

down. The down macro specifies the counter to count down for 10 
cycles.

load. The load macro reads a load vector P from the infile and loads 
the counter.

The “load,” “up,” “load,” and “down” commands execute the macros, 
as follows: “load” loads [00000000] into the counter, “up” cycles the 
counter up 10, “load” loads [11111111] into the counter, and “down” 
cycles the counter down 10.

Example Input File
The following input file (infile) was used in this example.

0b00000000
0b10000000
0b01000000
0b11000000
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Example Comparison File
The following comparison file (compfile) was used in this example.

00010001
10010001
01010001
01111111
10111111
00111111
11011111
01011111
10011111
00011111
11101111
01101111
10101111

Example Output File
The following output file (outfile) was created as a result of the 
command file used in this example.

1001000000001100000010
1001000000001010000010
1001000000001110000010
1001000000001001000010
1001000000001101000010
1001000000001011000010
1001000000001111000010
1001000000001000100010
1001000000001100100010
1001000000001010100010
1000111111111011111110
1000111111111101111110
1000111111111001111110
1000111111111110111110
1000111111111010111110
1000111111111100111110
1000111111111000111110
1000111111111111011110
1000111111111011011111
1000111111111101011111
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Command File 
Example 2

The following example is a command file for an 8-bit counter circuit:

(define (clock) (emit “Clocking\n”) (h clock) (step) (l clock) 
(step))
(define (clear) (l clr) (step) (h clr) (step)
(emit "The Counter is Cleared\n"))

(vector outputs out7 out6 out5 out4 out3 out2 out1 out0)
(vector inputs in7 in6 in5 in4 in3 in2 in1 in0)
(emit "Enabling Counter B\n")
(h cen1)
(step)
(clear)
; Set input signals
(h in1 in3 in5 in7)
(l in0 in2 in4 in6)
(step)
(print inputs outputs)
(repeat 5 (clock) (print outputs))

The “define” commands create the “clock” and “clear” macros.

The “vector” command is used to define the “inputs” and “outputs” 
vectors.

The “emit” command writes text out to the screen.

The “h” and “l” commands are used to set particular signals to logic 1 
(h) or logic 0 (l).

The “print” command prints the current state of “inputs” and “outputs” 
vectors.

The “repeat” command prints the output vector to the screen after 
every clock cycle.
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Example Output File
The following output file (outfile) was created as a result of the 
command file used in this example.

Enabling Counter
The Counter is Cleared
inputs = 10101010
outputs = 00000000
Clocking
outputs = 00000001
Clocking
outputs = 00000010
Clocking
outputs = 00000011
Clocking
outputs = 00000010
Clocking
outputs = 00000011
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7
Silicon Explorer Diagnostic Tool

This chapter contains information and procedures to setup and access 
the Silicon Explorer diagnostic tool for in-circuit testing of programmed 
Actel devices. This includes setup information and a description of the 
Explore window and the optional Analyze window used to access the 
Silicon Explorer diagnostic tool. The Silicon Explorer is only available 
for the PC platform. Contact your local sales representative for 
information about purchasing Silicon Explorer.

In-Circuit Testing with Silicon Explorer
The Silicon Explorer diagnostic tool, purchased separately from the 
APSW software, is used to probe internal nodes of an Actel device and 
consists of the Probe Pilot adapter, the Explore window accessed 
through the APSW software, and the optional Analyze window. It is 
useful for debugging your device while it is operating in a system. The 
Silicon Explorer is different from the Actel Debugger tool in that the 
device being tested receives all input stimulus from the user’s system.

The Silicon Explorer interfaces with a programmed device through a 
standard COM port on a PC. Using the Explore window, the Silicon 
Explorer can be used to dynamically monitor signal behavior on a 
device using two dedicated pins on the device. The Analyze window is 
an 18-channel logic analyzer that displays timing analysis of both the 
probe outputs and up to 16 additional signals on the user’s system. 
Each tool may be used separately.

Actel also offers the Silicon Explorer Lite, which does not include the 
Analyze window and relies on an external scope or logic analyzer for 
viewing signals.
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Probe Pilot
The Probe Pilot connects to a standard serial port on a PC using either 
an 8250 or 16550 UART and establishes communication using the 9-Pin 
D-Sub connector. The Probe Pilot is shown in Figure 7-1.

Note: Devices being tested with the Silicon Explorer receive all input 
stimulus from the user’s system.

Connecting 
The Probe Pilot 
to the Target

The Probe Pilot is shipped with a replaceable target cable assembly 
(TCA-8020A) that interfaces the Probe Pilot to your target system. Align 
the short red wire on the TCA-8020 with the red dot on the case and 
make certain that the 2mm header is fully inserted. The contacts on the 
TCA-8020 accept standard 0.025" round or square test accessories.

Powering the 
Probe Pilot

The Probe Pilot is powered by the target running at 3.0VDC to 5.5VDC. 
When power is applied, the yellow “heart beat” LED on the Probe Pilot 
begins to blink.

The Silicon Explorer is designed to withstand the conditions normally 
found in a lab environment. However, long term exposure to out-of-

Figure 7-1. Silicon Explorer
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range conditions can cause failure. In particular, long term connection 
to reverse- or over-voltage power conditions can cause thermal failure.

Current 
Consumption

The Probe Pilot is a CMOS device and exhibits very low current 
consumption at idle and rises rapidly to several hundred milliamps 
during acquisition. If your power supply is unable to supply the 
necessary current, the Probe Pilot or your target may reset. Table 7-1 is 
a guide to typical current consumption based on an acquisition rate at 
5V. Current will be proportionately higher at 3V.

Using an 
External Power 
Supply

If your target system cannot power the Probe Pilot, use the following 
procedure to connect an external supply:

1. Connect the Probe Pilot ground and the power supply 
ground to the target.

2. Connect the 5V lead of the supply to the 5V lead of the Probe 
Pilot.

A low cost regulated 5V 1 amp power supply is available from:

Digi-Key (800) 344-4539
Digi-Key# T310
Cui #DTR050100-P-1

Connecting the 
Probe Pilot to 
the FPGA

The Probe Pilot has a 22-pin (18 channels, a clock, VCC, GND, and 
clock GND) and a 16-pin connector for FPGA debug, using the Actel 
Action Probe circuitry. The Probe Pilot Lite only has the 16-pin 
connector.

Table 7-1. Typical Current Consumption

Acquisition Rate Current@5V Probe

IDLE 125ma Probe Pilot Lite

10MHz 350ma Probe Pilot

20MHz 450ma Probe Pilot

50MHz 550ma Probe Pilot

100MHz 750ma Probe Pilot
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Connecting Signals to the Target for Logic Analysis
The information in this section applies to using the Analyze window 
and is not available if you purchased Silicon Explorer Lite. Connect any 
of the Probe Pilot’s 18 channel leads to the desired target signals using 
standard test accessories. To sample synchronously, connect the CLKIN 
lead to the target’s clock which must be a continuous signal. If the 
clock is greater than 20MHz, connect the CLK-GND (twisted pair) to a 
ground point near the CLK lead.

Connecting the 
Probe Leads

You can connect the probe leads by attaching one of two supplied 
cable assemblies. 

One cable assembly terminates in individual 0.025 receptacles that can 
connect to 0.025 headers or micro-clips according to the labels on the 
wires. The other assembly interfaces directly to the target board when 
a 16-pin header is installed on the target according to the pin-out 
shown in Figure 7-2.

The Probe A and B pins on the probe connector may be selected as 
the source for logic analyzer channels 1 and 2 respectively, by clicking 
on the # field in the Analyze window and selecting PRA or PRB as the 
source. Selecting the probe pins as the source disables the CH1 and/or 
CH2 inputs from the target cable assembly.

Figure 7-2. Pinouts
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Explore Window
The Explore window is accessed through the APSW programming 
software. Figure 7-3 shows the Explore window that is displayed when 
the Action Probe software is invoked.

The left side of the Explore window displays the module layout for the 
design being debugged. As you move the cursor around this side of 
the window, the instance name for each module is displayed in the 
bottom left corner of the Explore window.

The right side of the Explore window is the Internal Nets list box that 
displays the net names for all internal nets found in the design being 
debugged. This window can be configured to display the net names in 
a flattened or hierarchical format. By default, the nets are displayed 
hierarchically.

Figure 7-3. Explore Window
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Using Silicon Explorer with the Explore Window
Silicon Explorer diagnostics can be executed through the Explore 
window in APSW. You must connect the Silicon Explorer to your PC 
and an Actel device on the user’s circuit board and invoke the Action 
Probe software to access the Silicon Explorer diagnostic tool. This 
section contains procedures to use the Silicon Explorer diagnostic tool.

To access the Silicon Explorer diagnostic tool:

1. Connect the Silicon Explorer. Connect one end of the Silicon 
Explorer to a COM port on your PC and the other end to the Actel 
device on the circuit board.

2. Invoke APSW. Double click the “Windows Programming” icon 
located in the Designer Series program group. The APSW window 
is displayed (see Figure 4-1 on page 30). You may see the following 
message displayed in the APSW main window:

Ignore this warning. The Probe Pilot is connected to the COM port 
and it does not need a SCSI controller or an Activator 2.

3. Open the design to debug. Click the Open button or choose the 
Open command from the File menu. The Open dialog box is 
displayed. Type in the design name or browse to the directory that 
contains the <design_name>.adb (or .afm) file and select it. Click 
OK.

4. Invoke the Action Probe software. Click the Action Probe button 
or choose the Action Probe command from the Tools menu. The 
Explore window is displayed (Figure 7-3). A message is displayed 
in the APSW main window stating “Debugger Initialization 
Complete.”

5. Select the COM Port. Select the COM Port you connected the 
Silicon Explorer to by choosing the appropriate COM port from the 
Explorer Port Menu located under the Probe menu. Assigning the 
COM port enables the Probe A and Probe B buttons.

Loading Activator 2 firmware...
SCSI controller not found
Warning: Could not connect with Activator 2
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6. Choose the signal to observe. Click the signal name of the net 
you want to probe in the Internal Nets list box.

7. Choose the Probe to assign to the signal. Click the Probe A 
button or choose the Probe A command from the Probe menu to 
select Probe A. Click the Probe B button or choose the Probe B 
command from the Probe menu to select Probe B.

The status bar at the bottom of the Explore window shows the current 
net that is assigned to Probe A and Probe B. The Probe A and Probe B 
LED indicators on the Probe Pilot become active when a successful 
probe has been established. When the LED is on, the Probe A or Probe 
B pins are at a logic high; when the LED is off, the pins are at a logic 
low.

Specify Nets or 
Pins to be 
Displayed

Use the following procedure to set the method of net or pin display in 
the Explore window.

1. Open the List Boxes Configuration dialog box. Choose the 
Configure List Box command from the Options menu. The List 
Boxes Configuration dialog box is displayed (Figure 7-4).

2. Choose the List Type. Under List Type, choose Flat for a flattened 
net list or Hierarchical for a hierarchical listing of net names.

Figure 7-4. Explore List Box Configuration Dialog Box



Chapter 7: Silicon Explorer Diagnostic Tool

64

3. In the Name box Enter the name of signal(s) you want to 
display. The Name box can take the wildcard character “*” to list 
all net names containing a particular string. The default lists all net 
names in the design.

4. Choose the type of signal to display. Choose the Show internal 
nets or Show internal pins option in the Internal Nets or Pins box. 
The same signals are available for probing regardless of the 
configuration you choose. The choice of “nets” or “pins” is given 
for the user’s convenience. 

5. Apply the changes. After the choices are made, click the Apply 
button to apply the changes without closing the dialog box or the 
OK button to apply the changes and close the dialog box.

Analyze Window
The Analyze window is not available if you purchased Silicon Explorer 
Lite. On installation, the Analyze window is set to the Demo mode. 
You may select COM 1 through 4 by selecting the port from the 
acquisition menu. The Analyze software continuously polls the Probe 
Pilot for activity. Setting the port to the Demo mode prevents the 
application from opening any COM ports on your system.

The COM port information is saved in the analyze.ini file found in your 
Windows directory.

The Analyze software defaults to 115,200 baud — at this speed data 
transfer will be less than 20 seconds for the entire buffer. On some 
slow systems (486-33MHz or less) particularly those with 8250 UARTs, 
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better performance could occur at 57,600 baud due to the need to retry 
blocks at high speed.

Note: Many notebook computers share the external COM port with a 
built-in infrared (IR) port. You may have to enter your CMOS 
setup menu to enable the COM port.

Using Silicon Explorer with the Analyze Window
Invoke the Analyze icon from the Designer Series Program Group and 
check the status in the lower right corner of the display. If the COM 
port is properly selected and power has been applied, then the status 
will read IDLE. The analyzer captures 64K samples which are then 
uploaded to the host over the serial port. This should be the same 
COM port used for Probe Pilot and the Analyze window.

Figure 7-5. Analyze Window

Signal Name Trigger Position Bus Control Zoom Buttons

Status COM Port
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Acquisition parameters may be set from either the tool bar or the pull-
down menus. The parameters are shown in Table 7-2.

Once the acquisition parameters are set, click the Run button (red 
triangle) in the upper left to begin acquisition. At this point the 
analyzer will begin capturing data and after the initial 64K samples are 
acquired, sampling will continue until either the trigger pattern is 
recognized or the stop button (black square) is pressed (see Figure 7-
5).

During this period, the status window displays PRE for the pre-trigger 
state (although you may not see it if the trigger pattern is matched 
quickly).

Next, the POST state will be entered and data after the trigger pattern 
(or stop button) will be sampled until the post trigger requirement is 
fulfilled. Then the data are uploaded to the host (READ State with 
progress indicator). The entire upload process takes less than 20 
seconds, although you may zoom in and view data immediately as the 
buffer is uploaded as a background task.

At this point the data may be viewed. Panning and zooming are 
available from either the scroll bars, tool bar, or keyboard control. In 

Table 7-2. Acquisition Parameters

Acquisition Speed
10Khz to 100MHz asynchronous or syn-
chronous to 66MHz

Trigger Position
4K Pre Trigger 60K Post Trigger
32K Pre Trigger 32K Post Trigger
60K Pre Trigger 4K Post Trigger

Trigger Pattern

Left click on individual signals in the T 
column to specify don’t care, low, high, 
rising, falling or either edge. The trigger 
pattern is the logical AND of the 18 pat-
terns.
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addition, dragging a box in the display area displays a zoom window. 
Table 7-3 lists keyboard equivalents.

Cursors are placed by left-clicking or right-clicking in the display area. 
The time is displayed below the channel labels while the value is 
displayed in the C1 and C2 columns. The L or “Live” Column indicates 
the current state of the 18 channels when the analyzer is in IDLE.

The Analyze application offers many convenient features for viewing, 
saving and printing data. More detailed information is available from 
the on-line help system.

Table 7-3. Keyboard Equivalents

Key Function

Up Arrow Zoom In 2X

Down Arrow Zoom Out 2X

Left Arrow Scroll Earlier (Data moves Right)

Right Arrow Scroll Later (Data moves Left)

Page Up Jump One Screen Earlier

Page Down Jump One Screen Later

Home Jump to Trigger
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Diagnostic Self Test
The Silicon Explorer includes a test header for the Probe Pilot to 
perform functional tests of the I/O drivers. If you suspect that your 
Probe Pilot has a failed I/O driver, then you can perform the following 
test.

To test a Probe Pilot:

1. Connect the supplied ribbon cable from the Probe Pilot or 
Probe Pilot Lite to the test header and apply power to the 
terminals on the test header. Red is positive and Black is 
negative.

2. Disconnect the target cable assembly and snap the 2mm 
header into the end of the Probe Pilot, observing polarity. 
This step is not applicable on to the Probe Pilot Lite.

3. Invoke the Analyze window. Double click the “Analyze” icon 
located in the Designer Series program group. The Analyze window 
is displayed (see Figure 7-5 on page 65).

4. Test the Probe Pilot port. Make sure the status is IDLE, then 
choose the Self Test command from the Help menu.

To test a Probe Pilot Lite:

1. Connect the supplied ribbon cable from the Probe Pilot or 
Probe Pilot Lite to the test header and apply power to the 
terminals on the test header. Red is positive and Black is 
negative.

2. Invoke APSW. Double click the “Windows Programming” icon 
located in the Designer Series program group. The APSW window 
is displayed.

3. Open a design. You must open a design to access the Action Probe 
software. Click the Open button or choose the Open command 
from the File menu. The Open dialog box is displayed. Type in the 
design name or browse to the directory that contains a 
<design_name>.adb (or .afm) file and select it. Click OK
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4. Invoke the Action Probe software. Click the Action Probe button 
or choose the Action Probe command from the Tools menu. The 
Explore window is displayed (Figure 7-3). A message is displayed 
in the APSW main window stating “Debugger Initialization 
Complete.”

5. Test the Probe Pilot port. Make sure the status is IDLE, then 
choose the Self Test command from the Help menu.
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A
Troubleshooting

This appendix describes some common problems you may encounter 
with the Activator, Adaptec 1505 SCSI card, or APSW or APS2 software 
and their solutions. If you are still unable to resolve your problems 
after reading this Appendix contact Actel’s Customer Applications 
Center.

Driver Does Not Load under Windows
Problem: The software driver does not load during boot-up.

Solution: Check for the following:

• The 1505 card is installed properly.

• The IRQ and I/O address settings match between the 1505 card and 
the software driver.

• The software driver is the correct one.

• There are no hardware conflicts.

Refer to Chapter 2, “Hardware Installation on a PC” on page 7 for 
information.

Activator
This section describes problems you may encounter with an Activator 
and their solutions.

Green Power 
Light is Blinking

Problem: The green power light is blinking after the power is turned 
on.

Solution: A self test has failed. Contact Actel for a replacement 
Activator.
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Activator 
Communication
Link Down

Problem: The following error message appears:

Solution: There is a problem with the connection between the 
Activator and the PC, or the Activator has lost power. Check the 
connections (the Activator power light should be illuminated), and try 
re-invoking APSW.

Firmware Load 
Failed

Problem: No contact with the programmer is found and the following 
error message appears:

Solution: Check that you have turned on the Activator, that the SCSI 
cable is correctly installed, and the SCSI cable connection to the 
workstation is secure. The locking arms on the SCSI board can be 
misaligned. Also, verify that the device driver(s) are installed correctly. 
Refer to Chapter 2, “Hardware Installation on a PC” on page 7 or 
Chapter 3, “Hardware Installation on a Workstation” on page 21 for 
information about configuring drivers.

Wrong 
Adapter 
Module

Problem: The incorrect Adapter Module is inserted in the Activator and 
the following error message appears:

Solution: Remove the Adapter Module and replace it with the correct 
one. The design may have also been configured with a different 
package or device type.

ERROR: Activator communication link down. Exiting...

Firmware load failed. WARNING: Could not connect with Activa-
tor.

FAILED—Wrong adapter module
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Old Revision If the Adapter Module does not support the selected device, even if the 
correct package is selected, the following message is displayed:

AFM File
This section describes problems that you may encounter when 
opening an AFM file and their solutions.

AFM File 
Generation

Problem: Generating the AFM file is taking a long time.

Solution: Depending on device type, device utilization, and machine 
speed, this process could take a few minutes. If 15 minutes have 
passed without completion, the hard disk may be out of memory. Exit 
APSW and check available disk space. If there is less than 1 megabyte, 
free up some disk space and try generating the .afm file again.

AFM 
Generation 
Failure

Problem: AFM file generation failed.

Solution: The software could not find a valid FUS file. The file may not 
be present or it may have been created with a release prior to ALS 
1.22. You must regenerate the FUS file using Designer.

Fuse
This section describes problems that you may encounter during 
programming and their solutions.

Failed Fuse Problem: The following error message appears:

Solution: This message often indicates that the device is bad. If you 
observe a programming failure rate in excess of 5%, contact the Actel 
Customer Application Center at 1-800-262-1060.

Old revision adapter module

FAILED—fuse XXX integrity test 6, 7, or 8
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Failed 
Programming 
Fuse

Problem: The following error message appears:

Solution: This message often indicates that the device is bad. If you 
observe a programming failure rate in excess of 5%, contact the Actel 
Customer Application Center at 1-800-262-1060.

When an antifuse is programmed, multiple voltage pulses are applied 
to the VPP pin. While the pulses are applied, IPP current is checked. If 
the antifuse is open (unprogrammed), there will be no IPP current. The 
Activator can tell if the antifuse has been programmed once it detects 
IPP current. Pulses are applied until IPP current is detected, or the 
maximum number of pulses is exceeded. If the antifuse does not 
program after the maximum number of pulses are applied, a “FAILED 
Programming Fuse” message is displayed on the screen and the failed 
antifuse number is shown. 

BAD fuse failures are often caused by a poor connection of the VPP pin 
to the socket pin. This is especially true if the part fails programming 
on the first antifuse. Remove the part and check for bent pins. If the 
pins are not bent and the other parts continue to fail with the “FAILED 
Programming Fuse” error, then the VPP pin of the socket could be 
damaged. Contact Actel’s Customer Applications Group.

SCSI Controller
Problem: SCSI Controller not found.

Solution: The SCSI controller board has not been installed in the PC, or 
there is an I/O address conflict. Also, verify that the device driver(s) 
are installed correctly. Refer to the Hardware Installation chapter 
specific to your computer for information about configuring drivers. If 
you are working on a workstation, verify that no other APSW 
processes are running. Only one APSW process may run at a time.

FAILED—programming fuse XXXX



Fuse Failures

75

Fuse Failures
This section describes failure messages that appear when a fuse fails to 
program.

Check 6 Failure Once the antifuse has been programmed, the Activator addresses the 
same antifuse again and checks for IPP current at a lower VPP voltage. 
This is to make sure that the anitfuse was correctly addressed the first 
time and that the IPP current did not come from another source. If no 
current is detected with this new test, the chip fails programming and 
APSW/APS2 issues the “Integrity test 6” failure for the antifuse. Once 
again, the antifuse number that failed is displayed.

Check 7 and 8 
Failures

This test is only performed on ACT 1 and 40MX devices. After the 
Activator completes the “CHECK 6” test, it then does two additional 
tests to make sure that an additional antifuse was not programmed 
mistakenly. The first test checks antifuses on the same column as the 
programmed antifuse, and the second test checks the same row. The 
tests are done by addressing these other antifuses, applying a voltage 
to VPP and making sure no IPP current is detected. If the tests fail (IPP 
current is detected), a “FUSE INTEGRITY FAILURE” failure is displayed.

Error Messages
This section describes general programming error messages that might 
be displayed.

Integrity Test Incorrectly programmed fuses, like the Check 7 and 8 failures above, 
are reported in the following format:

This message indicates that the device is a programming reject. Actel 
will replace devices that fail programming.

Integrity test <test type>. <test number>
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Fuse Current 
Sense Test

This test is not performed on ACT 1 or 40MX devices. This test is done 
to ensure that a logic module output is not inadvertently programmed 
to GND or VCC. The error message’s format is the following:

Not Blank If the device has been programmed and programming is attempted, 
the following message is displayed:

Silicon Explorer
This section describes error messages that might be displayed during 
debugging using the Silicon Explorer diagnostic tool, and the reason 
the message is displayed.

POLL Message Problem: I’ve connected Probe Pilot and the Analyze window display 
reads “POLL.”

Solution: Look on the top of the Probe Pilot for the flashing yellow 
LED. If it isn’t flashing, make sure you have properly connected an 
adequate power supply.

Problem: It’s flashing but still POLL.

Solution: There are a number of things that can prevent 
communication from being established. The following lists the most 
common:

1. Wrong COM port. Try all four COM ports even though you’re sure 
that your mouse is on COM 1.

2. No power to the analyzer.

3. Desktop Systems External connector not connected to the COM 
port internally.

4. Laptop Systems external COM connector disabled. Use your PC’s 
CMOS setup program to enable the COM port.

Fuse <fuse number>, current sense test <test number>

Not blank
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5. Com port IRQ reassigned for DOS program, control panel not 
updated.

6. Multiple mouse drivers in system.ini.

7. Third-party serial port “enhancers” not conforming to windows API.

IDLE Problem: I’ve got the IDLE message but when I click on Run, the 
Analyze window flashes an error message and returns to IDLE.

Solution: If the target power is incapable of supplying the necessary 
current, then the Analyze window resets and returns to IDLE.  Many 
current-limiting supplies will trip when set too close to the operating 
current.

Read-Back 
Error

Problem: The Analyze window acquires data and then indicates errors 
on read-back.

Solution: The Analyze window bursts data back in blocks at high 
speeds, with built-in retry for a bad block (both Checksum and byte 
count are used). Some third-party serial programs block all interrupts 
forcing the analyzer into a retry loop. Some laptops power down the 
UART and drop a few characters. Try disabling “Power Saving” in the 
CMOS setup menu.

Windows Runs 
Slow

Problem: When the Analyze window is open, my other Windows 
programs run slow.

Solution: If the Analyze window is open but it is not connected or 
powered up, then the system is constantly timing out looking for a 
response.  Either close the Analyze window or change the COM port to 
DEMO.
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AVI File Description

The AVI file is a log file generated while an Actel FPGA is 
programmed. The file contains information about the number of VPP 
pulses applied to each fuse to program the fuse and the programming 
current sensed through each fuse. If a programming failure occurs, the 
AVI file contains information about the programming failure mode.

A new AVI file is generated each time the programming sequence 
begins. If you want to save an AVI file, you must re-name it before 
restarting the programming sequence. The following excerpt shows an 
example AVI file:

*************************************************************
; FILEID AVI \example.avi
; PROGRAM Activator (tm) 2 Programming System 3.1.1
; VAR DDFDIE c:\ACTEL/data/a1200/1280/G1280.ddf
; VAR DDFPACKAGE c:\ACTEL/data/a1200/1280/qfp172.ddf
; VAR FUS \designs\mod25\mod25.fus
; VAR AFM \designs\mod25\mod25.afm: Compressed
; VAR SIG 
; ACT-FUSE: Fuse 1
; SILICON-SIGN 4:   5F80000      FFE   600000        0   FD335C
; ICC-STANDBY: 22 - - -
; IPP-STANDBY:0
; ESBIN: 3
; START-TIME Mon Mar 18 17:59:12 1996
; 4 3 2 1
1: 146 11 - - - - - -
2: 146 7 - - - - - -
3: 146 10 - - - - - -
4: 146 8 - - - - - -
5: 146 8 - - - - - -
6: 146 9 - - - - - -
7: 146 11 - - - - - -
8: 146 7 - - - - - -
9: 146 4 - - - - - -
10: 146 8 - - - - - -
11: 146 10 - - - - - -
12: 146 20 - - - - - -
13: 146 10 - - - - - -
14: 146 5 - - - - - -
15: 146 15 - - - - - -
16: 146 18 - - - - - -
17: 146 9 - - - - - -
18: 146 11 - - - - - -
*************************************************************
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The first thirteen lines of the file shown above contain header 
information. This information is obtained from both the programming 
file (.afm or .fus) and the unit being programmed. Each line of the AVI 
file header is preceded by a semi-colon. The header contains the 
following information:

• The complete Silicon Signature (read from the device) prior to 
programming.

• The ICC standby value of the device before it is programmed. In the 
example, the ICC standby of 22 corresponds to a standby of 2.2mA.

• The device “esbin” number, which corresponds to the VPP used 
during programming.

The remainder of the AVI file contains information about the 
programming sequence. As each fuse is programmed, a new line is 
added to the AVI file. The first column of numbers in the AVI file is the 
fuse number. A typical RH1280 design requires approximately 15700 
fuses to be programmed. The AVI file would contain over 15700 lines, 
including header information.

There are 8 additional columns in the AVI file. The 8 columns are listed 
in groups of 2, with each group corresponding to a socket on the 
Activator 2 (sockets are numbered 1-4). If the Activator 2s is used, the 
single socket is always recognized as socket 4.

The first column in a group of 2 contains the final programming 
current sensed by the Activator through each fuse as it is programmed. 
The programming current is listed in tenths of milliamps, and no 
decimal point appears in the number. For example, a programming 
current listed as 146 corresponds to current of 14.6mA . It is not 
unusual for different fuse types to have different programming 
currents.

The second column in a group of 2 contains the number of VPP pulses 
that were required to program a specific fuse. The maximum number 
of programming pulses reported in the AVI file is 64464 pulses. There 
is an inherent variation in the number of pulses required to program a 
fuse depending on the fuse type. A wide distribution of VPP pulse 
counts can be expected.

After the array fuse programming information, test results from the 
“end of programming” tests executed by the Activator are stored. If any 
of these tests fail, the failing test is indicated in the AVI file.
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Product Support

Actel backs its products with various support services including 
Customer Service, a Customer Applications Center, a fax back service, 
a Web and FTP site, electronic mail, and worldwide sales offices. This 
appendix contains information about using these services and 
contacting Actel for service and support.

Actel U.S. Toll-Free Line
Use the Actel toll-free line to contact Actel for sales information, 
technical support, requests for literature about Actel and Actel 
products, Customer Service, investor information, and using the Action 
Facts service.

The Actel Toll-Free Line is (888) 99-ACTEL.

Customer Service
Contact Customer Service for non-technical product support, such as 
product pricing, product upgrades, update information, order status, 
and authorization.

From Northeast and North Central U.S.A., call (408) 522-4480.
From Southeast and Southwest U.S.A., call (408) 522-4480.
From South Central U.S.A., call (408) 522-4474.
From Northwest U.S.A., call (408) 522-4434.
From Canada, call (408) 522-4480.
From Europe, call (408) 522-4474 or +44 (0) 1256 305600.
From Japan, call (408) 522-4252.
From the rest of the world, call (408) 522-4252.
Fax, from anywhere in the world (408) 522-8044.
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Customer Applications Center
The Customer Applications Center is staffed by applications engineers 
who can answer your hardware, software, and design questions.

All calls are answered by our Technical Message Center. The center 
retrieves information, such as your name, company name, phone 
number and your question, and then issues a case number. The Center 
then forwards the information to a queue where the first available 
application engineer receives the data and returns your call. The 
phone hours are from 7:30 a.m. to 5 p.m., Pacific Standard Time, 
Monday through Friday.

The Customer Applications Center number is (800) 262-1060.

European customers can call +44 (0) 1256 305600.

Guru Automated Technical Support
Guru is a Web based automated technical support system accessible 
through the Actel home page (http://www.actel.com). Guru provides 
answers to technical questions about Actel products. Many answers 
include diagrams, illustrations and links to other resources on the Actel 
Web site. Guru is available 24 hours a day, seven days a week.

Action Facts
Action Facts is a 24-hour fax-back service that allows you to have 
technical literature faxed directly to you. The literature includes current 
applications notes, device diagrams, radiation testing reports, CAE-
related documents, training release schedules, and much more. 

To receive your free copy of the catalog or any of our literature, 
contact us at (800) 262-1062 or (408) 739-1588.
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Web Site
Actel has a World Wide Web home page where you can browse a 
variety of technical and non-technical information. Use a Net browser 
(Netscape recommended) to access Actel’s home page.

The URL is http://www.actel.com. You are welcome to share the 
resources we have provided on the net. 

Be sure to visit the “Actel User Area” on our Web site, which contains 
information regarding: products, technical services, current manuals, 
and release notes.

FTP Site
Actel has an anonymous FTP site located at ftp://ftp.actel.com. You 
can directly obtain library updates, software patches, design files, and 
data sheets.

Electronic Mail
You can communicate your technical questions to our e-mail address 
and receive answers back by e-mail, fax, or phone. Also, if you have 
design problems, you can e-mail your design files to receive assistance. 
The e-mail account is monitored several times per day. 

The technical support e-mail address is tech@actel.com.
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Worldwide Sales Offices

Actel Corporation
955 East Arques Avenue
Sunnyvale, California 94086
USA
Toll Free: 888.99.ACTEL
Tel: 408.739.1010
Fax: 408.739.1540

Actel Europe, Ltd.
Daneshill House, Lutyens Close
Basingstoke,
Hampshire RG24 8AG
United Kingdom
Tel: +44 (0)1256.305600
Fax: +44 (0)1256.355420

Actel Asia-Pacific
EXOS Ebisu Building 4F
1-24-14 Ebisu Shibuya-ku
Tokyo 150 Japan
Tel: +81 (0)3.3445.7671
Fax: +81 (0)3.3445.7668

California (North)
Tel: 408.328.2200
Fax: 408.328.2358

England
Tel: +44 (0)1256.305600
Fax: +44 (0)1256.355420

Japan
Tel: +81 (0)3.3445.7671
Fax: +81 (0)3.3445.7668

California (South)
Tel: 714.727.0470
Fax: 714.727.0476

France
Tel: +33 (0)1.40.83.11.00
Fax: +33 (0)1.40.94.11.04

Korea
Tel: +82 (0)2.555.7425
Fax: +82 (0)2.555.5779

Georgia
Tel: 770.844.4495
Fax: 770.844.1395

Germany
Tel: +49 (0)8165.9584.0
Fax: +49 (0)8165.9584.10

Illinois
Tel: 847.259.1501
Fax: 847.259.1572

Italy
Tel: +39 (0)2.38.09.32.59
Fax: +39 (0)2.38.09.32.60

Massachusetts
Tel: 508.635.0010
Fax: 508.635.9510

Texas
Tel: 972.235.8944
Fax: 972.235.9659
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1505 Card. See Adaptec AVA-1505 AT-to-SCSI 
Adapter
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